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PENDAHULUAN 
 

 

A. Konsep Perancangan Struktur Beton Tahan Gempa 

Indonesia merupakan negara yang berada di wilayah Cincin Api Pasifik, 

sehingga sangat rentan terhadap bencana gempa bumi. Sejarah mencatat berbagai 

kejadian gempa besar seperti di Aceh (2004), Yogyakarta (2006), dan Palu (2018) 

yang menyebabkan kerusakan struktural signifikan dan korban jiwa. Oleh karena itu, 

perancangan struktur bangunan yang tahan gempa menjadi krusial untuk 

meminimalkan risiko, memastikan keselamatan penghuni, dan mempertahankan 

fungsi bangunan pasca-gempa. Standar Nasional Indonesia (SNI) menyediakan 

pedoman teknis untuk ini, khususnya SNI 1726:2019 tentang "Tata Cara Perencanaan 

Ketahanan Gempa untuk Struktur Bangunan Gedung dan Nongedung" dan SNI 

2847:2019 tentang "Persyaratan Beton Struktural untuk Bangunan Gedung". Kedua 

standar ini diadaptasi dari standar internasional seperti ASCE 7-16 dan ACI 318M-

14, dengan penyesuaian kondisi lokal Indonesia. SNI 1726:2019 fokus pada prosedur 

analisis dan desain seismik secara umum, sementara SNI 2847:2019 menekankan 

persyaratan material, detail penulangan, dan elemen struktural beton untuk ketahanan 

gempa. Kedua standar ini wajib diterapkan untuk bangunan baru sejak Februari 2022, 

dengan tujuan mencapai performa struktur yang daktil, sehingga mampu menyerap 

energi gempa tanpa kolaps total. 

Konsep perancangan struktur beton tahan gempa sesuai SNI menekankan 

prinsip desain berbasis performa, di mana struktur dirancang untuk menahan gaya 

seismik dengan mempertimbangkan kekuatan, kekakuan, daktilitas, dan disipasi 

energi. Pendekatan ini bertujuan agar struktur tetap elastis pada gempa kecil, 

mengalami kerusakan terkontrol pada gempa sedang, dan mencegah kolaps pada 

gempa besar (Maximum Considered Earthquake Risk-Targeted atau MCER). 

Persyaratan desain dan pendekatan bisa disesuaikan dengan tingkat respons 

inelastik yang diasumsikan dalam perhitungan gaya gempa desain. Maka dari itu, ada 

istilah “biasa”, “menengah”, dan “khusus”. Ketiga Sistem Rangka Pemikul Momen 

(SRPM) tersebut telah ditetapkan dalam SNI 1726:2019 tentang "Tata Cara 

Perencanaan Ketahanan Gempa untuk Struktur Bangunan Gedung dan Nongedung". 

Ada beberapa Kategori Desain Sesismik (KDS), yaitu KDS A sampai KDS F. 

BAB 1 
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1. Mutu Beton 

Mutu beton merujuk pada kualitas keseluruhan beton struktural yang 

mencakup kekuatan, durabilitas, kemampuan kerja (workability), dan ketahanan 

terhadap lingkungan. Dalam konteks Standar Nasional Indonesia (SNI) 

2847:2019 tentang "Persyaratan Beton Struktural untuk Bangunan Gedung", mutu 

beton ditentukan terutama oleh parameter teknis seperti kekuatan tekan 

karakteristik (f'c), yang menjadi dasar desain struktural. Standar ini diadaptasi 

secara identik dari ACI 318M-14 dan ACI 318RM-14, dengan penyesuaian untuk 

kondisi lokal Indonesia, seperti iklim tropis dan risiko gempa. Tujuan utamanya 

adalah memastikan struktur beton aman, stabil, dan tahan lama, dengan 

persyaratan minimum untuk kekuatan, stabilitas, kemampuan layan, durabilitas, 

dan integritas. 

Tulangan baja yang dikombinasikan dengan beton tersebut yang berfungsi 

untuk menahan gaya tarik atau lentur. Berdasarkan SNI 2847:2019 tentang 

“Persyaratan Beton Struktural Untuk Bangunan Gedung”. Beton bertulang 

mencakup elemen stuktural yang ditulangi dengan jumlah minimum baja 

prategang maupun nonprategang. 

Secara alamiah, beton sangat kuat dalam menahan gaya tekan. Sifat alami 

itu membuat beton mampu menahan kombinasi pembebanan seperti beban 

gravitasi, beban gempa, beban angin, sampai beban hujan. Menjadi pilihan utama 

untuk merancang struktur bangunan gedung bertingkat tinggi karena sifatnya 

tersebut dan juga mampu mendistribusikan beban secara ideal dan efisien. 

 

Tabel 1.1 

Klasifikasi Kelas Mutu Beton 

 

(Sumber: multiconjayabeton) 
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Tabel 1.2 

Klasifikasi Mutu Beton 

 

(Sumber: Luw Tjun Nji) 

 

2. Riwayat Gempa Northridge 

Adapun Gempa Northridge, yang juga dikenal sebagai Gempa Bumi 

Northridge 1994, merupakan salah satu bencana alam paling merusak dalam 

sejarah Amerika Serikat. Terjadi pada tanggal 17 Januari 1994, pukul 04:30:55 

pagi waktu Pasifik Standar (PST), gempa ini mengguncang wilayah Greater Los 

Angeles, khususnya Lembah San Fernando di California Selatan. Dengan skala 

gempa 6,7 SR. Gempa ini disebabkan oleh pecahnya sesar dorong buta (blind 

thrust fault) yang sebelumnya tidak diketahui, bernama Northridge Blind Thrust 

Fault atau Pico Thrust Fault. Gempa ini bertahan sekitar 8-20 detik, dengan 

akselerasi puncak tanah melebihi 1,7 g, yang merupakan tertinggi yang pernah 

direkam secara instrumental di wilayah urban Amerika Utara. Dampaknya 

dirasakan hingga San Diego, Las Vegas, Phoenix, dan Ensenada di Meksiko, 

menjadikannya gempa terbesar di wilayah Los Angeles sejak Gempa San 

Fernando 1971 (juga Mw 6,7). Gempa ini tidak hanya menyebabkan korban jiwa 

dan kerusakan struktural yang masif, tetapi juga menjadi katalisator perubahan 

signifikan dalam regulasi bangunan tahan gempa, asuransi, dan penelitian seismik 

di California. 

Gempa Northridge terjadi di wilayah yang sangat rawan seismik, yaitu 

Cincin Api Pasifik, di mana Lembah San Fernando mengalami kontraksi kerak 

bumi sekitar 7 mm per tahun akibat sistem sesar dorong dan thrust fault yang 

padat. Episenternya berada di Reseda, sekitar 30 km barat laut pusat kota Los 

Angeles, dengan hiposenter pada kedalaman sekitar 10 mil (16 km). Sesar yang 
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pecah menyebar ke atas dan barat laut dengan kecepatan 3 km per detik selama 8 

detik. 

3. Struktur Beton di Indonesia 

Struktur beton merupakan salah satu elemen utama dalam pembangunan 

infrastruktur di Indonesia, yang dikenal akan kekuatan, daya tahan, dan 

fleksibilitasnya dalam berbagai kondisi lingkungan. Di Indonesia, penggunaan 

beton sangat dominan dalam konstruksi bangunan gedung, jembatan, bendungan, 

dan infrastruktur lainnya karena sifatnya yang tahan terhadap iklim tropis, beban 

gempa, dan biaya yang relatif ekonomis. Perkembangan teknologi beton di 

Indonesia juga dipengaruhi oleh standar nasional seperti Standar Nasional 

Indonesia (SNI) untuk beton, yang mengacu pada pedoman internasional seperti 

ACI (American Concrete Institute), namun disesuaikan dengan kondisi lokal 

seperti risiko gempa dan ketersediaan material. 

Penerapan struktur beton di Indonesia tidak lepas dari tantangan, seperti 

kualitas material lokal, kebutuhan tenaga kerja terampil, dan adaptasi terhadap 

lingkungan geografis yang beragam, mulai dari daerah rawan gempa hingga 

wilayah pesisir yang rentan terhadap korosi. Penelitian dan inovasi terus 

dilakukan untuk meningkatkan performa beton, seperti penggunaan beton 

bertulang, beton pracetak, dan beton dengan campuran tambahan (admixture) 

untuk meningkatkan kuat tekan dan ketahanan terhadap lingkungan agresif. 

Adapun beberapa kelebihan beton bertulang antara lain: 

a. Kuat dalam menahan gaya tekan 

Secara alamiah beton sangat kuat dalam menahan gaya tekan. Sifat 

alami itu membuat beton mampu menahan kombinasi pembebanan seperti 

beban gravitasi, beban gempa, beban angin, sampai beban hujan. Menjadi 

pilihan utama untuk merancang struktur bangunan gedung bertingkat tinggi 

karena sifatnya tersebut dan juga mampu mendistribusikan beban secara ideal 

dan efisien. 

b. Durabilitas yang baik 

Memiliki ketahanan yang baik terhadap api dan air seperti berada 

dalam suhu yang ekstrem dan juga tingkat kelembaban yang tinggi. Lapisan 

beton melindungi tulangan baja dari korosi awal, membuatnya cocok untuk 

berada di lingkungan yang basah ataupun rawa terjadinya kebakaran. Beton 

juga tahan dalam menahan getaran, yang mana sangat cocok untuk daerah 

rawan gempa seperti Indonesia. 
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c. Awet 

Beton bertulang memiliki umur yang awet, minimal 50 tahun dengan 

perawatan yang minimum. Oleh sebab itu, banyak insinyur memilih 

menggunakan beton bertulang untuk merancang bangunan tingkat tinggi. 

d. Ekonomis 

Dengan bahan penyusun seperti semen, air, serta agregat halus dan 

kasar, membuat beton relatif lebih murah dan mudah ditemukan di pasaran. 

Proses pembuatannya tidak memerlukan kemampuan khusus dari tenaga ahli 

yang mahal, sehingga biaya keseluruhan lebih rendah jika dibandingkan 

dengan struktur baja. 

e. Fleksibel 

Memiliki sifat yang fleksibel, terutama dengan desain arsitektur yang 

kompleks, seperti lengkungan yang tajam dan bentang yang panjang, 

membuat beton menjadi populer ditambah dengan beton bisa langsung dicor 

di tempat (cast in situ). 

f. Ramah lingkungan 

Sifatnya yang juga ramah lingkungan sehingga dapat didaur ulang 

menggunakan bahan tambahan (admixture modern) untuk mengurangi emisi 

karbon selama proses produksi. Struktur beton juga memiliki sifat yang dapat 

mengisolasi suara dan termal yang baik sehingga meningkatkan kenyamanan 

dan keamanan penghuni.  

Adapun beberapa kekurangan beton bertulang antara lain: 

a. Lemah tarik 

Beton murni lemah terhadap menahan gaya tarik. Maka dari itu, 

diperlukan struktur tambahan berupa tulangan baja/besi beton untuk menahan 

gaya tarik maupun lentur. Perhitungan untuk menambah tulangan baja 

memerlukan analisis sesuai dengan standar yang berlaku di Indonesia. Jika 

hasil analisis “tidak aman”, maka beton bertulang berisiko gagal bahkan 

hancur. 

b. Self weight yang besar 

Beton bertulang memiliki massa jenis sekitar 2,4 ton/m3, yang mana 

angka tersebut bisa sangat besar, terutama beton yang memiliki bentuk atau 

luas penampang yang besar juga. Hal tersebut berdampak kepada makin 

besarnya dead load dari sebuah bangunan dan dead load tersebut juga masih 

harus dikalikan faktor 1,2. 
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c. Waktu konstruksi yang lama 

Terutama pada proses pengecoran yang mana bisa memerlukan waktu 

lama (tergantung luasan yang dicor), juga memerlukan bekisting yang banyak 

ditambah lagi beton harus memiliki umur minimal 28 hari untuk mencapai 

kuat tekan rencana sehingga membuat proyek konstruksi memerlukan waktu 

yang lama. 

d. Sulit untuk dimodifikasi 

Saat beton mengeras, akan sulit untuk melakukan suatu modifikasi 

(jika ada perubahan pada rencana awal). Hal itu membuat beton harus 

dibobok, atau bahkan dibongkar dan memiliki risiko kerusakan yang 

signifikan 

B. Desain Seismik Rangka Pemikul Momen Khusus 
dan Dinding Geser 

Desain seismik merupakan aspek kritis dalam perencanaan struktur bangunan 

di Indonesia, mengingat negara ini terletak di wilayah Cincin Api Pasifik yang rawan 

gempa. Dua sistem struktur utama yang sering digunakan dalam desain tahan gempa 

adalah Struktur Rangka Pemikul Momen Khusus (SRPMK) dan Dinding Geser 

(Shear Wall). Kedua sistem ini dirancang untuk menahan beban gempa dengan 

memanfaatkan kekakuan, daktilitas, dan kapasitas disipasi energi yang berbeda, 

sesuai dengan karakteristik bangunan dan kondisi geologis setempat. Penjelasan 

berikut membahas prinsip desain, karakteristik, serta penerapan kedua sistem ini 

berdasarkan standar yang berlaku di Indonesia. 

Sistem Rangka Pemikul Momen Khusus dirancang khusus untuk menahan 

momen lentur dan gaya geser melalui sambungan kaku antara balok dan kolom, 

memungkinkan deformasi plastis yang terkendali untuk mendisipasi energi gempa 

tanpa kegagalan mendadak. Sistem ini telah menjadi standar umum di Indonesia sejak 

pengembangan kode seismik pada awal 2000-an, di mana penekanan pada daktilitas 

tinggi dan konsep "strong column weak beam" menjadi kunci untuk mencegah 

keruntuhan progresif. Penelitian terkini menunjukkan bahwa SRPMK efektif untuk 

bangunan menengah hingga tinggi di daerah seismik sedang seperti Jakarta, di mana 

kategori desain seismik D sering diterapkan, meskipun memerlukan perincian 

tulangan yang teliti untuk menghindari kerapuhan. Kombinasi dengan elemen lain, 

seperti dinding geser, sering digunakan untuk meningkatkan kekakuan lateral, 

terutama pada struktur tinggi yang rentan terhadap simpangan berlebih akibat gempa. 

Dinding geser, di sisi lain, berfungsi sebagai elemen vertikal yang kaku untuk 

menahan gaya lateral, mengurangi simpangan (drift) antar lantai dan mencegah 

kerusakan nonstruktural selama gempa. Di Indonesia, sistem ini semakin populer 
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untuk bangunan tinggi, di mana integrasi dengan SRPMK dan shear wall membentuk 

sistem ganda yang optimal, seperti pada desain core wall dengan moment frames. 

Tantangan utama termasuk adaptasi terhadap tanah lunak di wilayah pesisir dan 

kebutuhan fondasi yang kuat untuk menahan momen jungkir, yang telah diatasi 

melalui inovasi seperti penggunaan beton berkinerja tinggi dan analisis dinamis. 

Standar seperti SNI 2847:2019 menekankan detailing khusus untuk dinding geser 

agar mencapai daktilitas yang diperlukan, sementara penelitian global mendukung 

penerapannya untuk meningkatkan performa seismik secara keseluruhan. 

 

 

Gambar 1.1 Sistem Rangka Pemikul Momen Khusus 

 

 

Gambar 1.2 Dinding Geser 
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1. Perilaku Rangka Pemikul Momen 

Menurut SNI 1726:2019, Rangka Pemikul Momen (Moment Resisting 

Frame) adalah sistem struktur rangka yang terdiri dari elemen-elemen seperti 

balok dan kolom yang dihubungkan secara kaku, dirancang untuk menahan beban 

lateral seperti gempa melalui mekanisme lentur, geser, dan aksial. Sistem ini 

dibagi menjadi tiga jenis berdasarkan tingkat daktilitas dan kategori desain 

seismik: Rangka Pemikul Momen Khusus (SRPMK) untuk daktilitas tinggi di 

wilayah gempa tinggi (nilai faktor respons seismik R=8), Rangka Pemikul 

Momen Menengah (SRPMM) untuk daktilitas sedang (R=5), dan Rangka 

Pemikul Momen Biasa (SRPMB) untuk daktilitas rendah (R=3) dan bisa 

disesuaikan dengan Kategori Desain Seismik (KDS). Perilaku keseluruhan sistem 

ini bergantung pada kemampuan sambungan kaku untuk mentransfer momen, 

sehingga memungkinkan struktur menyerap energi gempa tanpa keruntuhan 

prematur, dengan fokus pada reduksi respons spektrum gempa untuk desain 

ekonomis. 
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Tabel 1.3 

Koefisien untuk SRPMK dan Dinding Geser 

 

(Sumber: Tabel 12 SNI 1726:2019) 
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Perilaku seismik Rangka Pemikul Momen, khususnya SRPMK, dirancang 

untuk menunjukkan daktilitas tinggi, yaitu kemampuan struktur mengalami 

deformasi plastis berulang tanpa kehilangan kapasitas beban secara signifikan. Di 

bawah beban gempa, sistem ini memanfaatkan pembentukan sendi plastis 

terutama pada balok, sementara kolom tetap elastis atau mengalami deformasi 

minimal, sesuai konsep "strong column-weak beam" yang mencegah keruntuhan 

kolom dan progresif collapse. SNI 1726:2019 menekankan bahwa perilaku ini 

dicapai melalui reduksi gaya gempa nominal hingga 1/8 dari gaya elastis, dengan 

energi sisanya diserap melalui deformasi inelastis, sehingga struktur dapat 

kembali ke posisi semula atau minimal tetap berdiri setelah guncangan kuat. 

Prinsip desain perilaku Rangka Pemikul Momen dalam SNI 1726:2019 

melibatkan analisis spektrum respons dan verifikasi kinerja seismik, di mana 

struktur harus memenuhi batas simpangan antar lantai (drift) untuk mencegah 

kerusakan nonstruktural. Untuk SRPMK, persyaratan detailing ketat seperti jarak 

sengkang minimum pada kolom dan balok, serta penguatan sambungan, 

memastikan perilaku daktil dengan indeks kerusakan rendah selama analisis 

dinamis riwayat waktu. Standar ini juga mengintegrasikan peta gempa 2017, yang 

meningkatkan gaya geser seismik hingga 27% dibandingkan versi sebelumnya, 

sehingga memengaruhi perilaku struktur dengan peningkatan kekakuan lateral 

dan kapasitas disipasi energi. 

Penerapan Rangka Pemikul Momen di Indonesia, sesuai SNI 1726:2019, 

sering dikombinasikan dengan sistem lain seperti dinding geser untuk bangunan 

tinggi di wilayah rawan gempa seperti Yogyakarta atau Palu, di mana perilaku 

struktur dievaluasi melalui perangkat lunak seperti ETABS untuk memastikan 

kesesuaian dengan kategori situs tanah (lunak, sedang, keras). Tantangan 

termasuk adaptasi terhadap peningkatan intensitas gempa, memerlukan evaluasi 

ulang desain existing untuk memenuhi standar baru, dengan fokus pada perilaku 

pasca-elastis yang aman dan ekonomis. Inovasi seperti penggunaan reduced beam 

section pada rangka baja juga diadaptasi untuk meningkatkan perilaku seismik, 

memastikan struktur tetap aman meskipun deformasi signifikan. 

2. Analisis Rangka Pemikul Momen 

Rangka pemikul momen (moment-resisting frame) adalah sistem 

struktural pada bangunan beton bertulang yang dirancang untuk menahan beban 

lateral, terutama gempa, melalui mekanisme lentur, geser, dan aksial pada balok, 

kolom, dan sambungan. Sistem ini dibagi menjadi tiga tingkatan: Rangka Pemikul 

Momen Khusus (SRPMK), Rangka Pemikul Momen Menengah (SRPMM), dan 

Rangka Pemikul Momen Biasa (SRPMB), dengan SRPMK sebagai yang paling 

daktail dan cocok untuk wilayah gempa tinggi (seperti zona 5-6 di Indonesia). 

Analisis rangka pemikul momen mengintegrasikan perhitungan beban gempa dari 

SNI 1726-2019 dengan desain elemen beton dari SNI 2847-2019, menggunakan 
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metode kekuatan batas (ultimate strength design) untuk memastikan keamanan, 

daktilitas, dan ekonomi struktur. 

3. Desain Sambungan Balok-Kolom dan Konstruksinya 

Sambungan balok-kolom didefinisikan sebagai bagian dari kolom dengan 

kedalaman balok terdalam terhadap kolom. Oleh karena itu, maka istilah sendi 

digunakan mengacu pada sambungan balok-kolom. Sambungan adalah gabungan 

antara kolom, balok, dan pelat yang berdekatan dengan sendi. Sebuah balok yang 

melintang merupakan salah satu frame ruang berada dalam sendi dengan arah 

yang tegak lurus dengan arah geser yang sedang diperhitungkan. Dalam desain 

gedung bertingkat, kolom akan bertemu dengan balok. Daerah pertemuan itu 

merupakan sambungan. Sambungan sering kali menjadi bagian terlemah dari 

sistem struktur. 

Berdasarkan konsep desain kapasitas, diharapkan sambungan berperilaku 

ductile terhadap beban yang besar, seperti gempa. Perilaku yang diharapkan dari 

sambungan balok kolom adalah ductile dengan respons inelastik pada saat 

mengalami beban gempa kuat. Ada banyak cara yang mungkin ditempuh untuk 

menentukan jenis pembebanan dan kombinasinya. Identifikasi yang tepat pada 

masalah ini menjadi kunci sukses untuk menentukan detail sambungan. 

Kebutuhan dasar untuk performa sambungan menurut Park dan Paulay (1975) 

adalah sebagai berikut: 

a. Sambungan menunjukkan performa beban layan sama dengan kualitas elemen 

yang disambung; 

b. Sambungan memiliki kekuatan yang paling tidak berhubungan dengan 

kombinasi beban merugikan yang dapat didukung oleh elemen yang 

disambung; 

c. Kekuatan sambungan tidak menentukan kekuatan struktur dan perilakunya 

tidak menghalangi pengembangan kekuatan penuh elemen yang disambung; 

dan 

d. Mudah dibuat dan memiliki akses untuk menempatkan dan memadatkan 

beton. 

Untuk mencapai kondisi struktur yang daktail, maka perlu dijaga 

kegagalan pada struktur beton agar tidak terjadi dengan mudah kegagalan geser 

dan kegagalan tekan yang bersifat getas. Kegagalan ini terjadi pada titik 

pertemuan antara balok dan kolom. Beton memiliki kuat tekan yang relatif tinggi 

dibandingkan dengan bahan-bahan lain, tetapi kuat tariknya sangat rendah, 

sehingga memerlukan tulangan tarik. Tulangan tarik untuk beton bertulang 

menggunakan serat yang terbuat dari baja, plastik, kaca, dan lain-lain. Baja 

merupakan material yang paling sering digunakan sebagai serat tulangan. Sifatnya 

yang mudah terkena korosi menyebabkan kekuatan beton bertulang berkurang, 
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namun baja ditanam pada beton, sehingga selimut beton akan melindungi baja 

dari kemungkinan korosi. 

Ada dua jenis tulangan yang digunakan pada sambungan kolom-balok, 

yaitu tulangan longitudinal balok dan tulangan transversal joint. Gaya pada 

tulangan longitudinal di muka sambungan ditentukan dengan menganggap bahwa 

tegangan pada tulangan lentur 1,25fy. Tulangan yang berhenti pada sebuah kolom 

harus dilanjutkan sampai sisi terjauh dari inti kolom terkekang dan diangkur. 

Tulangan longitudinal balok yang diteruskan sampai melewati sambungan, 

dimensi kolom pada arah sejajar tulangan tersebut tidak boleh kurang dari 20 kali 

diameter tulangan terbesar balok untuk beton normal (SNI 2847:2019). 

Bila tulangan momen negatif balok menggunakan tulangan berkepala 

(headed deformed bar) yang berhenti di dalam joint, maka ujung atas kolom harus 

diteruskan di atas joint setidaknya setinggi h. Sebagai alternatif, tulangan balok 

harus dikekang pada muka atas joint oleh tulangan joint vertikal tambahan. 

Kuat geser nominal (Vn joint) harus memenuhi tabel di bawah: 

 

Tabel 1.4 

Kuat Geser Nominal pada Joint (Vn Joint) 

 

(Sumber: Pasal 18.8.4.1 SNI 1726:2019) 
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Gambar 1.3 Kuat Geser Nominal Pada Joint (Vn Joint) 

(Sumber: Pasal 18.8.4.1 SNI 1726:2019) 

 

Berikut ini kategori klasifikasi sambungan pada balok-kolom berdasarkan 

pada kondisi pertemuan koneksi dan deformasi yang diantisipasi dari anggota 

frame ketika melawan beban lateral 

a. Tipe 1. Sambungan yang terdiri dari anggota frame yang dirancang untuk 

memenuhi syarat pada ACI 318-02, tetapi tidak termasuk pada bagian yang 

tanpa deformasi inelastik; dan 

b. Tipe 2. Anggota frame yang dirancang untuk memiliki kekuatan berkelanjutan 

di bawah deformasi pembalikan ke kisaran inelastik. Persyaratan untuk 

sambungan tergantung pada anggota yang terdeformasi pada bagian sendi, 

tersirat oleh desain kondisi beban. Sambungan tipe ini adalah sambungan yang 

memiliki bagian yang diperlukan untuk mengurangi energi melalui 

pembalikan deformasi ke jangkauan inelastik yang dirancang sesuai ACI 318-

02. 

Berdasarkan model sambungan yang direncanakan dalam menahan beban 

mulai dari kondisi elastik hingga inelastik, maka sambungan dibedakan menjadi: 

a. Elastis dan inelastis 

Sambungan sedapat mungkin diusahakan dalam keadaan elastis. Sendi 

plastis balok diperkirakan terjadi pada muka balok apabila struktur dilanda 

gempa. Setelah beberapa kali terjadi siklus deformasi inelastis pada balok, 

maka tidak dapat dihindarkan deformasi juga akan terjadi pada sambungan 

balok-kolom. Hal ini disebabkan karena adanya penetrasi regangan leleh pada 
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baja tulangan balok yang melintas pada sambungan balok kolom khususnya 

apabila baja tulangan mencapai “perkuatan regangan” (strain hardening) pada 

sendi plastis yang berbatasan dengan muka kolom dan diklasifikasi sebagai 

sambungan balok kolom yang “inelastis”. Jika deformasi inelastis tidak terjadi 

pada balok dan kolom yang berbatasan dengan sambungan balok–kolom dan 

memiliki tulangan yang cukup, maka diklasifikasikan sebagai sambungan 

balok-kolom yang “elastis”. 

b. Khusus 

Pada sambungan balok-kolom ini dibutuhkan tulangan yang rapat, 

namun sering menimbulkan kesulitan dalam pelaksanaannya, terutama pada 

sambungan balok-kolom sebelah dalam (interior) yang dilintasi oleh tiga 

jurusan tulangan serta penjangkaran pada sambungan portal tepi dan 

sambungan pada balok–kolom bagian pojok (exterior). Pembesaran balok 

(voute) dalam arah horizontal pada sekeliling sambungan balok–kolom 

dengan penerusan sebagian balok pada portal tepi dari kolom balok bagian 

pojok dilakukan untuk mengatasi hal itu. 

Konstruksi penulangan sambungan balok-kolom beton adalah desain yang 

mempertemukan balok dan kolom dengan penempatan tulangan yang saling 

terhubung dan tertanam kuat untuk menyalurkan beban, menekankan panjang 

penyaluran yang memadai (penyaluran tulangan), dan penggunaan sengkang 

(tulangan transversal) dengan jarak yang rapat di zona sambungan untuk menahan 

geser dan deformasi. Detail penulangan harus mengikuti standar beton bertulang 

seperti SNI, dengan mengintegrasikan tulangan balok ke dalam kolom dan atau 

menggunakan sambungan yang kokoh seperti kaitan 90° atau sambungan lewatan 

sesuai perhitungan desain. 

 

 

Gambar 1.4 Konstruksi Sambungan Balok-Kolom 
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PEMODELAN STRUKTUR 
 

 

A. Data Umum Bangunan 

Pada buku ini akan diberikan contoh langsung pemodelan struktur bangunan 

gedung 26 lantai yang berfungsi sebagai kantor arsip. 

Berikut adalah data umum bangunan: 

a. Nama proyek  : Gedung Kantor 26 Lantai 

b. Lokasi proyek  : DKI Jakarta 

c. Panjang bangunan : 40 meter 

d. Lebar bangunan : 40 meter 

e. Jarak antar kolom : 8 meter 

f. Luas bangunan : xxx m2 

g. Jumlah lantai  : 26 

h. Fungsi   : Kantor Arsip 

i. Sistem struktur : Dinding Geser Beton Bertulang Khusus 

Data-data di atas adalah informasi umum dalam merancang gedung kantor 

yang harus mampu menahan beban gravitasi, beban angin, beban hujan, sampai beban 

gempa. Untuk merancang struktur bangunan high rise ini, penulis menggunakan 

sebuah software yang memang dikhususkan untuk menganalisis bangunan gedung, 

yaitu ETABS. 

 

 

Gambar 2.1 Software ETABS 

BAB 2 
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B. Pembuatan Grid 

Sebelum membuat sebuah grid/AS dari gedung kantor 26 lantai tersebut, ada 

baiknya kita mengetahui bagaimana site plan/tata letak bangunannya. Gunanya 

adalah agar kita mengetahui di mana saja letak bangunan-bangunan yang ada di site 

plan ini. 

Akan tetapi, di buku ini hanya membahas langkah demi langkah bagaimana 

cara merancang gedung kantor 26 lantai ini dan mengabaikan tata letak bangunan lain. 

Site plan bisa dilihat di bawah ini. 

 

 

Gambar 2.2 Site Plan Kawasan Gedung Kantor 

 

 

Gambar 2.3 Denah Arsitektur Gedung Kantor 
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Pada menu New Model Quick Template, pilih opsi Blank. Selain itu, juga 

terdapat beberapa pilihan lain yang bisa digunakan dalam membuat grid. Akan tetapi, 

pada buku ini penulis memilih yang opsi Blank. 

 

 

Gambar 2.4 Opsi Grid pada Software ETABS 

 

 

Gambar 2.5 Tampilan Awal Model Pada ETABS 

 

Untuk memudahkan pemodelan dan menganalisis struktur gedung yang akan 

kita rancang, maka terlebih dahulu kita mengubah satuan pada software ETABS yang 

digunakan. Di sini penulis menggunakan satuan Metric S.I Defaults. 
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Gambar 2.6 Menyesuaikan Penggunaan Satuan 

 

Yang dilakukan selanjutnya adalah membuat grid pada arah X dan arah Y, 

dan juga membuat jarak antar tingkatnya. 

 

 

Gambar 2.7 Tahap Selanjutnya dalam Membuat Grid 
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Gambar 2.8 Edit Story and Grid System Data 

 

Ada dua cara untuk menambahkan/mengedit grid baik arah X maupun arah Y: 

• Memasukkan sesuai dengan ordinat; dan 

• Memasukkan jarak antar AS. 

Di sini, penulis memilih cara yang kedua, yaitu memasukkan jarak antar AS. 

Bangunan kantor 26 lantai ini memiliki ukuran yang relatif sederhana, yaitu 40 meter 

x 40 meter dengan jarak antar kolom utama 8 meter. 
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Gambar 2.9 Modify/Show Grid System 

 

 

Gambar 2.10 Edit Grid System 
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Gambar 2.11 Modify/Show Story Data 
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Gambar 2.12 Story Data 
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Gambar 2.13 Grid yang Telah Dibuat 

 

C. Pembuatan Properti Material 

Setelah kita membuat grid bangunan, maka selanjutnya adalah menentukan 

properti material yang akan digunakan untuk merancang struktur gedung 26 lantai ini. 

Material yang digunakan di antaranya: 

1. Beton 

2. Tulangan baja 

Cara membuat properti material tersebut di atas adalah dengan memilih menu 

Define, piliih opsi Material Properties. 
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Gambar 2.14 Define Material Properties 

 

 

Gambar 2.15 Define Materials 

 

Adapun penentuan properti material yang akan dirancang harus mengikuti 

ketentuan di bawah. 

1. Beton bertulang 

Data: 

Kuat tekan (fc')  = 30 MPa 

Massa jenis   = 23.536 kN/m3 

Modulus elastisitas  = 4700*√fc' = 25.742, 96 MPa 

Angka poison (μ)  = 0,2 
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Gambar 2.16 Concrete Material Property Data 

 

 

Gambar 2.17 Concrete Material Property Design Data 
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2. Tulangan baja 

Berdasarkan SNI 2847:2019, spesifikasi material baja tulangan memenuhi 

persyaratan pasal 20.2.5 adalah baja tulangan kelas BJTS 420B. Spesifikasi teknis 

dari baja tulangan kelas BJTS 420B dapat diketahui berdasarkan Tabel 6 SNI 

2052:2017 di bawah. 

 

Tabel 2.1 

Sifat Mekanis Tulangan Baja 

 
(Sumber: SNI 2052:2017) 

 

Tabel di atas adalah acuan penulis yang selanjutnya akan mendefinisikan 

tulangan baja pada software ETABS. 

Data: 

Mutu tulangan baja = BJTD 420B 

Massa jenis  = 78,5 kN/m3 

Modulus elastisitas = 200.000 MPa 
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Tegangan leleh (fy) = 420 MPa 

Tegangan putus (fu) = 525 MPa 

Fye   = 1,25*420 MPa = 525 MPa 

Fue   = 1,25*545 MPa = 656,25 MPa 

Untuk tegangan leleh yang diharapkan (fye) dan tegangan putus yang 

diharapkan (fue) itu harus ditentukan sesuai faktor pada tabel di bawah ini. 

 

Tabel 2.2 

Faktor untuk Menentukan Fye dan Fue Tulangan Baja 

 
(Sumber: FEMA 356) 

 

 

Gambar 2.18 Rebar Material Property Data 
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Gambar 2.19 Rebar Material Property Design Data 

 

D. Pembuatan Properti Penampang 

Dalam merancang suatu bangunan, pastilah kita harus menentukan/membuat 

beberapa penampang seperti penampang pelat, balok dan kolom. Adapun beberapa 

ukuran penampang beton yang digunakan penulis dalam merancang gedung kantor 

26 lantai adalah sebagai berikut: 

1. Pelat lantai 

S 125   = Pelat lantai setebal 125 mm 

S 200   = Pelat lantai setebal 200 mm 

Adapun cara untuk membuat penampang pelat adalah dengan cara arahkan 

kursor ke menu Define → Section Properties → Slab Sections → Add New Property, 

maka akan muncul gambar di bawah. 

 

 

Gambar 2.20 Slab Properties 
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Gambar 2.21 Slab Property Data 

 

 

Gambar 2.22 Property/Stiffness Modification Factors for Slab 

 

2. Balok 

B 46   = 400 mm x 600 mm 

BA 300x500 X-2 = 300 mm x 500 mm 
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BI 300x500 X-2 (K)  = 300 mm x 500 mm 

BI 400x500 X-2 A (K) = 300 mm x 500 mm 

Adapun cara untuk membuat penampang balok mirip dengan membuat 

pelat, yaitu arahkan kursor ke menu Define → Section Properties → Frame 

Sections → Add New Property, maka akan muncul gambar di bawah. 

 

 

Gambar 2.23 Frame Properties 

 

 

Gambar 2.24 Frame Property Shape Type 
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Gambar 2.25 Frame Section Property Data 

 

Setelah memilih bentuk penampang balok beton, yakni persegi panjang, 

maka selanjutnya adalah memasukkan data-data yang telah ditentukan 

sebelumnya dan penting untuk menyesuaikan faktor modifikasi untuk balok yang 

sesuai dengan SNI 2847:2019. 

 

Tabel 2.3 

Faktor Modifikasi Kekakuan 

 

(Sumber: SNI 2847:2019 Tabel 6.6.3.1.1(a)) 
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Gambar 2.26 Property/Stiffness Modification Factor for Reinforcement Concrete Beam 

 

3. Kolom 

KI 1400x1400  = 1400 mm x 1400 mm 

KI 1200x1200  = 1200 mm x 1200 mm 

KI 700x700  = 700 mm x 700 mm 

KI 800x800  = 800 mm x 800 mm 

KI 900x900 (A) = 900 mm x 900 mm 

Adapun cara untuk membuat penampang kolom mirip dengan sama 

seperti balok, yaitu arahkan kursor ke menu Define → Section Properties → 

Frame Sections → Add New Property, maka akan muncul gambar di bawah. 

 

 

Gambar 2.27 Frame Properties 



 

 

  

 
 33  Pemodelan Struktur 

 

Gambar 2.28 Frame Property Shape Type 

 

 

Gambar 2.29 Frame Section Property Data 
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Gambar 2.30 Property Stiffness Modification Factor for Reinforcement Cooncrete 

Column 
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Gambar 2.31 Modify/Show Rebar 
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4. Dinding geser (shear wall) 

Cara membuat penampang dinding geser (shear wall) mirip dengan pelat, 

balok dan kolom, yaitu dengan memilih menu Define → Section Properties → 

Wall Sections → Add New Property, maka akan muncul gambar di bawah. 

 

 

Gambar 2.32 Wall Properties 

 

 

Gambar 2.33 Wall Property Data 

 

Untuk menentukan faktor modifikasi dinding geser, penulis mengacu 

kepada SNI 2847:2019 Pasal R6.6.3.1.1 seperti di bawah ini. 

 

 

Gambar 2.34 Faktor Modifikasi Dinding Geser 

(Sumber: SNI 2847:2019) 
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E. Pemodelan Balok, Kolom, Pelat dan Shear Wall 

Setelah membuat penampang dari pelat, balok, shear wall, dan kolom 

selanjutnya memodelkan properties tersebut. 

1. Memodelkan balok 

Pemodelan elemen balok beton bisa dilakukan dengan cara membuat 

model menjadi view denah terlebih dahulu, lalu klik menu Draw → Draw 

Beam/Column/Brace Object → Quick Draw Column, lalu pilih penampang balok 

yang akan digambar di model. Di sini penulis tidak memodelkan balok pada lantai 

dasar, akan tetapi langsung memodelkan pada lantai di atasnya (lantai 2). 

 

 

Gambar 2.35 Set Plan View 
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Gambar 2.36 Draw Beam 

 

Adapun cara untuk memilih properti penampang balok/beam yang akan 

dimodelkan adalah dengan memilih di bagian property balok tersebut. 

 

 

Gambar 2.37 Properties of Object (Beam) 
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Gambar 2.38 Balok yang Sudah Termodelkan 

 

Jika sudah tergambar, maka kita akan melakukan replika/menyalin model 

tersebut sampai ke lantai 26. 

2. Memodelkan kolom 

Langkah yang serupa bisa diterapkan untuk memodelkan properti kolom 

beton, yaitu klik menu Draw → Draw Beam/Column/Brace Object → Quick 

Draw Column, lalu pilih penampang kolom yang akan digambar di model dan 

juga arahnya. Di sini penulis menggunakan dua ukuran kolom sekaligus. Untuk 

kolom keliling bangunan menggunakan ukuran 1200 mm x 1200 mm dan untuk 

kolom tengah menggunakan ukuran 1400 mm x 1400 mm. Selalu awali dengan 

membuat model ke denah/plan terlebih dahulu agar memudahkan dalam 

penggambaran. 
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Gambar 2.39 Quick Draw Column 

 

 

Gambar 2.40 Properties of Object (Column) 



 

 

  

 
 41  Pemodelan Struktur 

 

Gambar 2.41 Kolom yang Sudah Termodelkan 

 

Jika sudah tergambar, maka kita akan melakukan replika/menyalin model 

tersebut sampai ke lantai 26. 

3. Memodelkan pelat lantai 

Untuk memodelkan pelat lantai, arahkan kursor ke menu Draw Floor/Wall 

Object. Ada tiga cara untuk menggambar pelat lantai: 

• Opsi Draw Floor/Wall 

Cara ini digunakan jika ada grid/AS bangunan yang tidak berbentuk 

persegi atau persegi panjang. 

• Opsi Draw Rectangular Floor/Wall 

Cara ini digunakan pada area yang berbentuk persegi atau persegi 

panjang, akan tetapi ini membuat pelat lantai menjadi terpisah (jika kita masih 

menganggap asumsi pelat satu arah dan dua arah). 
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• Opsi Quick Draw Floor/Wall 

Cara ini adalah cara tercepat dalam memodelkan pelat lantai. Dengan 

cara ini, kita bisa langsung membuat elemen pelat dari kolom satu ke kolom 

lainnya 

 

 

Gambar 2.42 Draw Floor/Wall Object 

 

Di sini, penulis menggunakan opsi Draw Rectangular Floor/Wall agar 

bisa membentuk elemen pelat lantai persegi atau persegi panjang dengan cara 

menyeret/drag kursor. Penulis melakukan replicate elemen sampai ke lantai 26. 
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Gambar 2.43 Pelat Lantai yang Sudah Termodelkan 

 

4. Memodelkan dinding geser/shear wall 

Untuk memodelkan dinding geser terlebih dahulu kita memilih model 3D 

pada bangunan yang dirancang. Adapun caranya adalah dengan klik icon 3-d 

seperti yang ditunjukkan gambar di bawah. 

 

 

Gambar 2.44 Mengembalikan Tampilan Menjadi 3D 

 

Di sini penulis menggunakan opsi Draw Rectangular Floor/Wall agar bisa 

membentuk elemen dinding geser/shear wall persegi atau persegi panjang. 
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Gambar 2.45 Opsi Untuk Memodelkan Dinding Geser/Shear Wall 

 

Setelah itu, perbesar bangunan yang dimodelkan dan arahkan ke lantai 

dasar. Penulis memodelkan dinding geser dari lantai dasar samai lantai 26 dengan 

cara yang sama. 

 

 

Gambar 2.46 Membuat Shear Wall di Lantai Dasar 

 

 

Gambar 2.47 Keseluruhan Shear Wall yang Termodelkan 
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BAB 3 
 

 

PEMBEBANAN STRUKTUR 
 

 

A. Pembebanan Pada Struktur Rangka Momen Khusus 
dan Dinding Geser 

Konsep pembebanan pada sistem rangka pemikul momen khusus (SRPMK) 

dan dinding geser dalam bangunan bertingkat tinggi melibatkan integrasi beban 

gravitasi dan lateral untuk memastikan kestabilan struktur terhadap gaya eksternal 

seperti gempa. Menurut SNI 1727:2020, beban gravitasi mencakup beban mati (berat 

struktur sendiri) dan beban hidup (beban penggunaan bangunan), yang dihitung 

sebagai beban minimum untuk perencanaan gedung. Sementara itu, SNI 1726:2019 

mengatur pembebanan lateral akibat gempa melalui prosedur seperti analisis 

spektrum respons, di mana SRPMK dirancang untuk menahan gaya lentur, geser, dan 

aksial secara daktail, sementara dinding geser fokus pada penahanan gaya geser 

horizontal. Kombinasi keduanya dalam sistem ganda memungkinkan distribusi beban 

yang efisien, di mana SRPMK harus memikul minimal 25% beban lateral gempa 

sesuai SNI 1726:2019, sehingga cocok untuk bangunan tinggi di daerah seismik 

tinggi. 

Pada sistem SRPMK, pembebanan difokuskan pada kemampuan rangka ruang 

untuk menahan momen lentur dan deformasi plastis tanpa kegagalan mendadak, 

sebagaimana dijelaskan dalam SNI 2847:2019 yang menekankan pendetailan 

tulangan beton untuk daktilitas penuh. Beban gempa dari SNI 1726:2019 dihitung 

berdasarkan faktor respons seismik, di mana kolom dan balok memikul campuran 

beban aksial, momen, dan geser, dengan prinsip "strong column-weak beam" untuk 

memastikan kegagalan terjadi pada balok terlebih dahulu. Dalam bangunan bertingkat 

tinggi, pembebanan ini dikombinasikan dengan reduksi beban mati dari SNI 

1727:2020 untuk mengoptimalkan dimensi elemen, sehingga struktur tetap ekonomis 

sambil menahan simpangan antar lantai yang dibatasi agar tidak melebihi ambang 

batas aman. 
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B. Beban Mati Pada Struktur 

Beban mati (self weight) adalah beban yang muncul akibat berat sendiri profil 

tersebut. Adapun massa jenis yang digunakan pada kasus ini dan juga pada berbagai 

jenis material terlampir pada tabel di bawah. 

 

Tabel 3.1 

Massa Jenis Baja dan Beton 

 

 

Tabel 3.2 

Massa Jenis Berbagai Material 

 

 

Beban mati tambahan (super imposed dead load/SD) adalah beban yang 

ditambahkan pada struktur yang bersifat permanen. Adapun beberapa beban mati 

tambahan yang digunakan pada kasus ini adalah: 
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1. Untuk lantai beton nonatap 

• Dinding hebel    = 110 kg/m2 

• Homogenous tile polished   = 110 kg/m2 

• Ceramic unpolished tile   = 110 kg/m2 

• Waterproofing + fin plester aci kasar = 25 kg/m2 

• Curtain wall    = 25 kg/m2 

• Equipment mekanikal/elektrikal  = 19 kg/m2 

• Langit-langit penggantung  = 10 kg/m2 

• Plafond     = 5 kg/m2 

• Floor hardener    = 3 kg/m2 

• Pegangan tangga    = 0,73 kN/m 

2. Untuk lantai beton atap 

• Dinding hebel    = 110 kg/m2 

• Curtain wall    = 25 kg/m2 

• Gondola     = 20 kg/m2 

• Floor hardener    = 3 kg/m2 

• Waterproofing + fin plester aci kasar = 25 kg/m2 

• Equipment mekanikal/elektrikal  = 19 kg/m2 

• Langit-langit penggantung  = 10 kg/m2 

• Plafond     = 5 kg/m2 

C. Beban Hidup pada Struktur 

Untuk keperluan desain, SNI 1727:2020 memungkinkan reduksi beban hidup 

berdasarkan luas area yang didukung oleh elemen struktur, seperti kolom atau balok, 

untuk mencerminkan kemungkinan rendahnya beban maksimum yang terjadi secara 

serentak di seluruh area besar. Faktor reduksi ini dihitung sesuai ketentuan standar, 

dengan batasan tertentu untuk memastikan keamanan struktur. Selain itu, beban hidup 

khusus seperti beban partisi, kendaraan, atau peralatan berat juga diatur dengan nilai 

spesifik sesuai jenis penggunaan, seperti garasi atau gudang. Standar ini menekankan 

pentingnya mempertimbangkan variasi beban hidup dalam analisis kombinasi beban 

untuk menjamin ketahanan dan efisiensi desain struktur. 

Beban hidup menurut SNI 1727:2020 didefinisikan sebagai beban yang 

dihasilkan dari penggunaan atau okupansi bangunan, tidak termasuk beban mati, 

beban lingkungan seperti angin atau gempa, maupun beban akibat konstruksi. Beban 

ini mencakup berat orang, furnitur, peralatan, dan benda bergerak lainnya yang 

bervariasi tergantung fungsi bangunan, seperti perumahan, perkantoran, atau fasilitas 

umum. SNI 1727:2020 menetapkan nilai minimum beban hidup seragam (dalam 
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kN/m²) dan beban terkonsentrasi (dalam kN) untuk berbagai kategori penggunaan 

bangunan, 

Berikut ini beberapa beban hidup yang digunakan pada perancangan gedung 

kantor 26 lantai. 

1. Live load (L) 

• Atap tempat berkumpul   = 4,79 kN/m2 

• Lobi dan koridor di atas lantai 1  = 3,83 kN/m2 

• Ruang kantor    = 2,4 kN/m2 

• Ruang arsip dan computer  = 1,92 kN/m2 

• Beban partisi    = 0,72 kN/m2 

2. Beban hidup pada atap (Lr) 

• Beban atap datar    = 0,96 kN/m2 

D. Pembuatan Load Pattern untuk Masing-Masing 
Pembebanan 

Pola pembebanan (load pattern) didefinisikan sebagai distribusi spasial dari 

serangkaian gaya, perpindahan, suhu dan pengaruh lain tertentu yang bekerja pada 

suatu struktur. Kombinasi sambungan dari elemen apa pun dapat dipengaruhi oleh 

kondisi pembebanan dan kinematika. Setiap pole pembebanan diberikan tipe 

desainnya sesuai dengan tipe bebannya (misalnya dead, super dead, live, wind, 

seismic, dan lain sebagainya. Pada software ETABS, penentuan load pattern dapat 

dilakukan dengan cara klik menu Define → Load Pattern → Add New Load seperti 

yang ditampilkan pada gambar di bawah. 
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Gambar 3.1 Define Load Pattern 

 

 

Gambar 3.2 Add New Load Patterns 
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E. Aplikasi Beban pada Struktur Melalui ETABS 

Untuk menambahkan beban pada struktur yang dimodelkan di software 

ETABS dimulai dengan pendefinisian load patterns, yang merupakan distribusi 

spasial dari beban-beban seperti dead load, live load, seismic, atau wind load. 

Pengguna dapat mengakses menu Assign → Frame Loads atau Shell Loads untuk 

menambahkan pola beban baru, di mana nama pola, jenis beban (misalnya reducible 

live atau other), dan multiplier self-weight ditentukan. Multiplier self-weight biasanya 

diatur ke 1 untuk pola dead load agar mencakup berat sendiri struktur, sementara pola 

lain diatur ke 0 untuk menghindari duplikasi. Untuk beban lateral seperti seismic atau 

wind, opsi auto lateral load dapat dipilih berdasarkan kode standar tertentu, yang 

secara otomatis menghitung dan mendistribusikan beban sesuai parameter yang 

dimasukkan. 

 

 

Gambar 3.3 Assign Loads 

 

1. Pengaplikasian beban pada pelat lantai 

Untuk mengaplikasikan beban pada pelat lantai, terlebih dahulu kita 

memilih/select pelat lantai yang akan ditambahkan bebannya, yaitu dengan cara 

klik menu Select → Select → Properties → Slab Sections, lalu pilih ukuran pelat 
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lantai yang akan diberikan beban. Di sini penulis melakukan penambahan beban 

pada pelat sampai ke lantai 26. 

 

 

Gambar 3.4 Slab Sections 

 

• Beban hidup pada pelat 

Lobi dan koridor di atas lantai 1  = 3,83 kN/m2 

Ruang kantor    = 2,4 kN/m2 

Partisi     = 0,72 kN/m2 

Untuk beban hidup ruang kantor dan partisi penulis melakukan 

penjumlahan langsung yaitu 3,12 kN/m2 

Setelah mengetahui beban hidup saja yang akan diaplikasikan pada 

pelat lantai, selanjutnya kita akan melakukan penginputan beban pada pelat 

tersebut. Caranya adalah klik menu Assign → Shell Loads → Uniform. 
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Gambar 3.5 Shell Uniform Loads 

 

 

 

Gambar 3.6 Shell Load Assignment 
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Gambar 3.7 Beban Hidup pada Pelat Lantai Yang Telah diaplikasikan 

 

• Beban mati tambahan pada pelat 

Tile     = 110 kg/m2 

Equipment mekanikal/elektrikal  = 19 kg/m2 

Langit-langit penggantung  = 10 kg/m2 

Plafond     = 5 kg/m2                 + 

      = 144 kg/m2 
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Gambar 3.8 Beban Mati Tambahan pada Pelat Lantai yang Telah Diaplikasikan 

 

2. Pengaplikasian beban pada balok 

Untuk mengaplikasikan beban pada balok, terlebih dahulu kita 

memilih/select balok yang akan ditambahkan bebannya, yaitu dengan cara klik 

menu Select → Select → Properties → Frame Sections, lalu pilih ukuran balok 

yang akan diberikan beban. Di sini penulis melakukan penambahan beban pada 

balok sampai ke lantai 26. 
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Gambar 3.9 Frame Sections 

 

 

Gambar 3.10 Select by Frame Propoerty 
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• Beban mati tambahan pada balok 

Dinding hebel (tinggi 4,2 m) = 110 kg/m2 x 4,2 m = 462 kg/m 

Curtain wall   = 25 kg/m2 x 4,2 m = 105 kg/m          + 

        = 567 kg/m 

Pegangan tangga      = 74,44 kg/m 

Setelah mengetahui beban mati tambahan saja yang akan diaplikasikan 

pada balok, selanjutnya kita akan melakukan penginputan beban pada pelat 

tersebut. Caranya adalah klik menu Assign → Frame Loads → Distributed. 

 

 

Gambar 3.11 Frame Loads 
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Gambar 3.12 Beban Mati Tambahan pada Pelat Balok yang Telah Diaplikasikan 
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BAB 4  

 

ANALISIS DAN DESAIN STRUKTUR 
RANGKA DUAL SISTEM MOMEN KHUSUS 

TERHADAP BEBAN GEMPA 
 

 

A. Analisis Kegempaan pada Struktur Rangka Pemikul 
Momen Khusus 

Analisis kegempaan pada struktur rangka pemikul momen khusus (SRPMK) 

merupakan pendekatan desain yang menekankan daktilitas tinggi untuk menahan 

beban gempa melalui mekanisme lentur, geser, dan aksial pada elemen balok serta 

kolom. Berdasarkan SNI 2847:2019, SRPMK dirancang dengan konsep "strong 

column weak beam" untuk memastikan kolom lebih kuat daripada balok, sehingga 

deformasi plastis terjadi terutama pada balok dan menghindari keruntuhan mendadak. 

Standar ini juga mengatur mutu beton minimum 21 MPa untuk struktur SRPMK, serta 

detail tulangan longitudinal dan sengkang yang ketat untuk meningkatkan kapasitas 

disipasi energi. Sementara itu, SNI 1726:2019 menyediakan tata cara perencanaan 

ketahanan gempa, termasuk penentuan zona gempa dan faktor respons seismik, 

sedangkan SNI 8460:2017 melengkapi dengan persyaratan geoteknik untuk fondasi 

yang mendukung stabilitas struktur di tanah rawan gempa. 

Dalam analisis kegempaan sesuai SNI 1726:2019, struktur SRPMK dievaluasi 

menggunakan metode response spectrum dinamis atau analisis statik ekuivalen untuk 

menghitung gaya geser dasar dan distribusi beban lateral. Faktor reduksi respons (R) 

untuk dual sistem biasanya bernilai 7, yang mencerminkan tingkat daktilitas tinggi, 

dengan koefisien overstrength (Ω0) sebesar 2,5 dan defleksi amplifikasi (Cd) 5,5. 

Analisis ini mempertimbangkan parameter situs seperti percepatan spektrum desain 

(SDS dan SD1) berdasarkan peta gempa nasional, serta efek torsi pada bangunan tidak 

beraturan. Integrasi dengan SNI 8460:2017 memastikan bahwa investigasi geoteknik, 

termasuk uji sondir atau bor, digunakan untuk menilai potensi likuifaksi tanah dan 

menentukan kapasitas dukung fondasi yang aman terhadap gaya gempa. 



 

 

  

 59 Analisis dan Desain Struktur Rangka Dual Sistem Momen Khusus terhadap Beban Gempa 

SNI 2847:2019 menekankan detail struktural SRPMK, seperti jarak sengkang 

maksimum 1/4 tinggi balok di zona sendi plastis untuk mencegah geser gagal, serta 

rasio tulangan minimum 1% hingga 6% pada kolom agar memenuhi kriteria ductile. 

Analisis kegempaan melibatkan verifikasi simpangan antar lantai (drift) tidak 

melebihi 0,02 kali tinggi lantai, serta pemeriksaan kapasitas sambungan balok-kolom 

menggunakan desain kapasitas untuk memastikan kinerja inelastis yang baik. 

 

Tabel 4.1 

Koefisien untuk Dual Sistem 

 

(Sumber: SNI 1726:2019 Tabel 12) 
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Secara keseluruhan, integrasi ketiga standar ini memastikan analisis 

kegempaan SRPMK holistik, mulai dari perencanaan seismik hingga detail geoteknik, 

sehingga struktur mampu menyerap energi gempa tanpa keruntuhan total. SNI 

8460:2017 khususnya menambahkan lapisan keamanan dengan persyaratan analisis 

stabilitas lereng dan mitigasi bahaya geoteknik seperti amblesan tanah pasca-gempa. 

Pendekatan ini telah diterapkan pada berbagai bangunan tinggi di Indonesia, 

menghasilkan desain yang lebih ekonomis dan aman, dengan simulasi perangkat 

lunak seperti ETABS untuk validasi. Hasilnya, SRPMK dan dual sistem menjadi 

pilihan utama untuk wilayah gempa tinggi, mendukung prinsip keselamatan 

masyarakat sesuai regulasi nasional. 

1. Penentuan Kategori Risiko Gempa dan Faktor Keutamaan Gempa 

Kategori risiko gempa menurut SNI 1726:2019 adalah klasifikasi yang 

digunakan untuk menentukan tingkat kepentingan dan potensi risiko bangunan 

terhadap gempa bumi, yang menjadi dasar penentuan faktor keutamaan gempa 

(Ie). Kategori ini dibagi menjadi empat tingkat (I hingga IV) berdasarkan fungsi 

bangunan, jumlah penghuni, dan konsekuensi kegagalan struktur terhadap 

keselamatan jiwa serta dampak sosial-ekonomi. Klasifikasi ini membantu 

insinyur dalam merancang struktur yang sesuai dengan tingkat ketahanan seismik 

yang diperlukan, memastikan bangunan esensial tetap berfungsi setelah gempa, 

sementara bangunan biasa dirancang dengan efisiensi yang tetap aman. 

Penentuan kategori risiko ini berperan penting dalam analisis desain 

seismik, seperti dalam metode statik ekivalen atau response spectrum, karena 

memengaruhi beban gempa desain dan simpangan struktur. Misalnya, bangunan 

kategori IV dirancang dengan beban gempa lebih besar untuk menjamin 

operasionalitasnya setelah kejadian seismik. SNI 1726:2019 juga memberikan 

pengecualian, seperti pada sistem isolasi seismik, di mana Ie diambil 1,0 untuk 

semua kategori risiko guna menghindari desain berlebihan. Dengan pendekatan 

ini, SNI 1726:2019 memastikan bahwa desain struktur seimbang antara 

keamanan, fungsi, dan efisiensi biaya sesuai dengan risiko seismiknya. 

Kategori risiko gedung kantor 26 lantai ini ditentukan berdasarkan fungsi 

bangunan. Bangunan yang dirancang berfungsi sebagai kantor yang memiliki 

kategori risiko II seperti yang ditampilkan pada tabel di bawah ini. 
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Tabel 4.2 

Kategori Risiko Bangunan Gedung dan Non-Gedung untuk Beban Gempa 

 

(Sumber: Tabel 3 SNI 1726:2019) 

 

Faktor keutamaan gempa (Ie) menurut SNI 1726:2019 merupakan 

parameter penting dalam perencanaan ketahanan struktur bangunan terhadap 

gempa bumi. Faktor ini berfungsi untuk menyesuaikan tingkat desain seismik 

berdasarkan tingkat risiko dan kepentingan fungsional bangunan, sehingga 

struktur yang lebih krusial mendapatkan perlindungan ekstra agar tetap beroperasi 

pasca-gempa. Dalam standar ini, Ie digunakan dalam perhitungan respons spektral 

percepatan gempa, di mana nilai tersebut dikalikan dengan parameter seperti SDS 

dan SD1 untuk menghasilkan beban gempa desain yang lebih akurat dan aman. 

Tujuannya adalah meminimalkan kerusakan pada fasilitas esensial, seperti rumah 

sakit atau pusat komando darurat, yang harus tetap fungsional selama dan setelah 

kejadian gempa. 

Nilai faktor keutamaan gempa ditentukan berdasarkan kategori risiko 

bangunan, sebagaimana diatur dalam SNI 1726:2019 Tabel 4. Kategori risiko I 

atau II, yang mencakup bangunan biasa seperti rumah tinggal atau gedung 

perkantoran standar, memiliki Ie sebesar 1,0. Sementara itu, kategori III untuk 

bangunan dengan occupancy tinggi atau risiko kerusakan signifikan terhadap 

masyarakat, seperti sekolah atau pusat perbelanjaan besar, menggunakan Ie 1,25. 

Untuk kategori IV, yang meliputi fasilitas esensial seperti rumah sakit, stasiun 

pemadam kebakaran, atau instalasi nuklir, Ie ditingkatkan menjadi 1,5 untuk 

memastikan ketahanan maksimal. 

Dalam aplikasi praktis, faktor keutamaan gempa ini terintegrasi dalam 

metode analisis seperti response spectrum atau statik ekivalen, di mana Ie 

memengaruhi besarnya gaya geser dasar (V) dan simpangan struktur. Misalnya, 

pada bangunan gedung kantor ini kategori II, Ie tetap 1,0, sehingga desain 



62 Desain Gedung Kantor 26 Lantai Menggunakan Sistem Ganda 

mengikuti beban standar. Namun, ada pengecualian khusus, seperti pada struktur 

dengan sistem isolasi seismik, di mana Ie diambil sebesar 1,0 terlepas dari 

kategori risiko, untuk menghindari overdesign. Hal ini memungkinkan 

perencanaan yang efisien sambil menjaga keselamatan sesuai dengan prinsip SNI 

1726:2019. 

 

Tabel 4.3 

Faktor Keutamaan Gempa (Ie) 

 

(Sumber: Tabel 4 SNI 1726:2019) 

 

2. Penentuan Kelas Situs dan Parameter Gempa 

Berdasarkan SNI 1726:2019, penentuan kelas situs adalah langkah krusial 

dalam analisis desain seismik untuk mengevaluasi karakteristik tanah di lokasi 

bangunan, yang memengaruhi respons struktur terhadap gempa. Kelas situs 

ditentukan berdasarkan parameter geoteknik, seperti kecepatan rambat 

gelombang geser (Vs), jumlah pukulan standar penetrasi (N-SPT), atau kekuatan 

geser tanah tak terdrainase (Su). Proses ini dimulai dengan pengumpulan data 

geoteknik melalui pengujian lapangan atau laboratorium, yang kemudian 

digunakan untuk mengklasifikasikan situs ke dalam salah satu dari enam kategori: 

SA (situs batuan keras), SB (batuan), SC (tanah keras), SD (tanah sedang), SE 

(tanah lunak), atau SF (tanah sangat lunak yang memerlukan studi khusus). 

Klasifikasi ini memengaruhi nilai parameter respons spektral (SDS dan SD1) yang 

digunakan dalam perhitungan beban gempa. 

Kelas situs ditentukan berdasarkan SNI 1726-2019 berdasarkan data 

penyelidikan tanah yang tersedia. Pada proyek ini, hanya diketahui satu jenis data 

penyelidikan tanah yang digunakan untuk menentukan kelas situs, yaitu berupa 

data N-SPT/Bore Hole. Terdapat dua data Bore Hole, yaitu BH-2 dan BH-3 yang 

dapat dilihat pada bagian lampiran. Berdasarkan SNI 1726-2019 apabila hanya 

memperhitungkan satu jenis data tanah, maka kelas situs yang digunakan adalah 

kelas situs yang paling rendah sesuai ketentuan yang terdapat pada SNI 1726- 

2019. Namun, pada perhitungan ini, penentuan kelas situs murni berdasarkan nilai 

yang diperoleh dari data N-SPT. Analisis data N-SPT untuk penentuan kelas situs 

disajikan pada tabel sebagai berikut. 
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Berdasarkan nilai N dari masing-masing data bore hole tersebut di atas, 

maka diperoleh nilai N̅ (N rata-rata) yaitu sebesar 49,14 (untuk BH-2) dan 49 

(untuk BH-2). Lalu kita lihat pada Tabel 5 SNI 1726:2019 untuk menentukan 

klasifikasi situsnya. 

 

Tabel 4.6 

Klasifikasi Situs 

 

 

Koefisien situs menurut SNI 1726:2019 adalah parameter penting yang 

digunakan untuk mengoreksi respons spektral gempa berdasarkan karakteristik 

geoteknik tanah di lokasi bangunan. Koefisien situs, yang terdiri dari Fa (koefisien 

amplifikasi untuk periode pendek) dan Fv (koefisien amplifikasi untuk periode 

panjang), ditentukan berdasarkan kelas situs (SA hingga SF) dan intensitas gempa 

yang diwakili oleh nilai percepatan spektral periode pendek (Ss) dan periode 

panjang (S1). Proses ini dimulai dengan penentuan kelas situs melalui pengujian 

geoteknik, seperti kecepatan rambat gelombang geser (Vs30), jumlah pukulan N-

SPT, atau kekuatan geser tanah (Su), sesuai Pasal 11.4 SNI 1726:2019. Koefisien 

ini kemudian digunakan untuk menghitung percepatan spektral desain (SDS dan 

SD1) yang menentukan beban gempa pada struktur. 

Penerapan koefisien situs dalam desain seismik dilakukan dengan 

mengalikan nilai Ss dengan Fa untuk mendapatkan SDS (SDS = 2/3 × Fa × Ss) 

dan nilai S1 dengan Fv untuk mendapatkan SD1 (SD1 = 2/3 × Fv × S1). Nilai ini 

kemudian digunakan dalam analisis response spectrum atau statik ekivalen untuk 

menghitung beban gempa desain. Penting untuk memastikan bahwa data 

geoteknik akurat, karena kesalahan dalam penentuan kelas situs dapat 

menyebabkan nilai koefisien yang tidak tepat, sehingga memengaruhi keamanan 

struktur. Untuk kasus khusus, seperti sistem isolasi seismik, SNI 1726:2019 
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memungkinkan penyesuaian tertentu untuk memastikan efisiensi desain tanpa 

mengorbankan ketahanan. Dengan pendekatan ini, SNI 1726:2019 memastikan 

bahwa efek tanah lokal diperhitungkan secara akurat dalam perencanaan struktur 

tahan gempa. 

Untuk menentukan nilai Ss (percepatan batuan dasar pada periode pendek) 

dan S1 (percepatan batuan dasar pada periode 1 detik) penulis menggunakan data 

dari website Desain Spektra Indonesia dari PUPR dan melakukan interpolasi 

sehingga didapatkan nilai Ss = 0,9163. 

 

 

Gambar 4.1 Menentukan Nilai Ss dari Website Desain Spektra Indonesia 

 

Berdasarkan lokasi koordinat proyek gedung kantor 26 lantai ini, maka 

dari itu, penulis menyimpulkan bahwa parameter respons spektrum desain yang 

digunakan ditampilkan seperti gambar di bawah. 

 

 

Gambar 4.2 Summary Parameter Respons Spektrum 

(Sumber: www.rsa.ciptakarya.pu.go.id/2021) 
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Setelah itu, data-data tersebut bisa langsung diinput pada respons 

spektrum di software ETABS. Caranya adalah klik menu Define → Functions → 

Response Spectrum. 

 

 

Gambar 4.3 Define Functions Response Spectrum 

 

Penting untuk diketahui bahwa SNI 1726:2019 merupakan adopsi dari 

standar ASCE7-16 dengan beberapa modifikasi yang disesuaikan dengan kondisi 

seismik dan geoteknik di Indonesia, seperti penerapan Peta Gempa Indonesia 

tahun 2017. Standar ini menggantikan SNI 1726:2012 yang sebelumnya diadopsi 

dari ASCE 7-10, sehingga pembaruan pada 2019 mencerminkan perkembangan 

terbaru dalam regulasi seismik internasional untuk meningkatkan ketahanan 

struktur terhadap gempa bumi. 
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Gambar 4.4 Define Response Spectrum Functions 

 

 

Gambar 4.5 Input Response Spectrum Functions Parameters 

 

Nilai koefisien situs (Fa dan Fv) untuk kelas situs D sudah otomatis 

dihitung oleh software, jadi penulis tidak memasukkannya secara manual. Akan 

tetapi, penting untuk diketahui, jika ingin memasukkan nilai Fa dan Fv pada 

software yang tidak terhitung otomatis adalah dengan merujuk pada Tabel 6 dan 

7 SNI 1726:2019 seperti di bawah. 
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Tabel 4.7 

Koefisien Situs (Fa) 

 

 

Tabel 4.8 

Koefisien Situs (Fv) 

 

 

 

3. Penentuan Kategori Desain Seismik 

Kategori Desain Seismik (KDS) dalam SNI 1726:2019 merupakan 

klasifikasi yang digunakan untuk menentukan tingkat persyaratan desain tahan 

gempa pada struktur bangunan gedung dan nongedung. KDS ini mencerminkan 

tingkat bahaya seismik di suatu lokasi, yang dibagi menjadi enam kategori yaitu 

A hingga F, di mana A menunjukkan risiko rendah dan F risiko tinggi. Penentuan 

KDS bertujuan untuk memastikan struktur dapat menahan guncangan gempa 

dengan probabilitas tertentu, berdasarkan peta hazard gempa Indonesia 2017. 

Faktor utama dalam penentuan ini meliputi parameter percepatan spektral desain 

serta kategori risiko bangunan, yang memengaruhi pemilihan sistem struktur dan 

detail desain. 

Implikasi dari penentuan KDS adalah persyaratan desain yang semakin 

ketat seiring meningkatnya kategori, seperti penggunaan sistem rangka pemikul 

momen khusus untuk KDS D ke atas guna meningkatkan daktilitas struktur. SNI 

1726:2019 menekankan investigasi geoteknik mendalam untuk KDS D, E, dan F, 
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termasuk penilaian potensi likuefaksi tanah. Hal ini memastikan bangunan tidak 

hanya bertahan dari gempa desain tetapi juga meminimalkan kerusakan, sesuai 

dengan prinsip risk-targeted maximum considered earthquake (MCER). 

Penggunaan tools seperti aplikasi Desain Spektra Indonesia membantu dalam 

perhitungan akurat parameter ini. 

Untuk menentukan Kategori Desain Seismik (KDS), bisa dilihat pada SNI 

1726:2019 Tabel 8 dan 9 di bawah. 

 

Tabel 4.9 

 Kategori Desain Seismik Berdasarkan Parameter Respons Percepatan  

pada Periode Pendek (SDS) 

 

 

Tabel 4.10 

Kategori Desain Seismik Berdasarkan Parameter Respons Percepatan  

pada Periode 1 Detik (SD1) 

 

 

B. Pemilihan Sistem Struktur 

Penentuan sistem struktur untuk high rise building menurut SNI 1726:2019 

didasarkan pada Kategori Desain Seismik (KDS) yang telah ditentukan sebelumnya, 

dengan tujuan memastikan ketahanan terhadap gaya lateral seperti gempa. High rise 

building, yang umumnya didefinisikan sebagai gedung bertingkat tinggi lebih dari 8 

lantai atau ketinggian struktural di atas 24 meter, memerlukan pemilihan sistem 

struktur yang mampu menahan beban seismik secara efektif. SNI 1726:2019 

mengadopsi pendekatan serupa dengan ASCE 7-16, di mana sistem struktur 

diklasifikasikan berdasarkan faktor respons modifikasi (R), faktor overstrength (Ω0), 

dan faktor defleksi amplifikasi (Cd). Pemilihan ini juga mempertimbangkan faktor 
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seperti kategori risiko bangunan (I-IV), kondisi situs tanah, dan batasan ketinggian 

struktur untuk mencegah kegagalan pada KDS tinggi seperti D, E, atau F. 

Kriteria pemilihan sistem struktur melibatkan penilaian KDS, di mana untuk 

KDS A hingga C (risiko rendah hingga sedang), hampir semua sistem diizinkan tanpa 

batasan ketinggian signifikan, sementara untuk KDS D hingga F (risiko tinggi), ada 

batasan ketinggian ketat. Misalnya, pada kasus ini menggunakan sistem ganda, yaitu 

kombinasi SRPMK dan Shear Wall. Batasan ini tercantum dalam Tabel 12 SNI 

1726:2019 seperti ditunjukkan di bawah. 

SNI 1726:2019 menggolongkan sistem struktur utama menjadi enam kategori 

utama untuk bangunan tahan gempa, yaitu: (1) Sistem Dinding Penumpu (Bearing 

Wall System), (2) Sistem Rangka Gedung (Building Frame System), (3) Sistem 

Rangka Pemikul Momen (Moment-Resisting Frame System), (4) Sistem Ganda (Dual 

System), (5) Sistem Interaksi Dinding Geser dan Rangka (Shear Wall-Frame 

Interaction System), dan (6) Sistem Kolom Kantilever (Cantilever Column System). 

Untuk high rise building, sistem seperti Sistem Rangka Pemikul Momen Khusus 

(SRPMK) atau Sistem Ganda dengan dinding geser khusus sering direkomendasikan, 

terutama pada daerah risiko gempa tinggi. 

Untuk sistem ganda, rangka pemikul momen harus mampu memikul paling 

sedikit 25 % gaya seismik desain. Tahanan gaya seismik total harus disediakan oleh 

kombinasi rangka pemikul momen dan dinding geser atau rangka bresing, dengan 

distribusi yang proporsional terhadap kekakuannya. 

 

Tabel 4.11 

Faktor R, Cd, dan  untuk Sistem Ganda 

 

 

 

Jika sudah mendapatkan nilainya, maka selanjutnya memasukkan nilai-nilai 

tersebut pada software ETABS. Caranya klik menu Define → Load Pattern → Add 
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New Load → berikan nama SE-X untuk arah X dan SE-Y untuk arah Y → Sesuaikan 

seperti gambar di bawah.  

 

 

Gambar 4.6 Mendefinisikan Pola Pembebanan 

 

 

Gambar 4.7 Mendefinisikan Pola untuk Beban Gempa 

 

Berdasarkan Tabel 18 SNI 1726:2019, nilai parameter periode pendekatan (Ct 

dan x) bisa ditentukan seperti yang ditunjukkan tabel di bawah ini. 
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Tabel 4.12 

Nilai Parameter Periode Pendekatan 

 

 

  

Gambar 4.8 Input Nilai Faktor R, Cd, dan  

 

1. Perhitungan Periode Struktur 

Perhitungan periode struktur menurut SNI 1726:2019 merupakan langkah 

krusial dalam desain tahan gempa untuk menentukan respons spektrum dan 

koefisien seismik Cs. Periode fundamental (T) mencerminkan waktu getar alami 

struktur, yang memengaruhi besarnya gaya lateral gempa. SNI ini mengadopsi 

pendekatan dari ASCE 7-16, dengan dua metode utama: pendekatan empiris 

untuk periode aproksimasi (Ta) dan analisis dinamis untuk nilai yang lebih akurat. 

Tujuan perhitungan ini adalah memastikan struktur berada dalam rentang periode 

yang aman, menghindari resonansi dengan guncangan gempa, terutama di 

wilayah berisiko tinggi seperti Indonesia. Parameter kunci meliputi tinggi struktur 

(hn), jenis sistem struktur, dan kondisi situs tanah yang memengaruhi amplifikasi. 
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Metode pendekatan untuk Ta menggunakan rumus Ta = Ct*hn^x, di mana 

hn adalah ketinggian struktur dari dasar hingga puncak (dalam meter), Ct adalah 

koefisien tergantung jenis struktur (misalnya 0,0466 untuk rangka momen khusus 

beton bertulang), dan x adalah eksponen (umumnya 0,9 untuk sistem tersebut). 

Untuk akurasi lebih tinggi, periode T dihitung melalui analisis modal 

dinamis menggunakan software seperti ETABS, yang memodelkan massa, 

kekakuan, dan distribusi beban struktur. Namun, ada batasan; periode dari analisis 

tidak boleh kurang dari 80% Ta untuk beberapa kasus, dan tidak melebihi Cu*Ta 

sebagai batas atas, di mana Cu adalah koefisien dari Tabel 17 SNI 1726:2019 

berdasarkan SD1 (misalnya Cu = 1,4 untuk SD1 = 0,2-0,3 g). Jika T > Cu*Ta, 

maka digunakan Cu*Ta untuk menghitung Cs minimum guna menghindari 

underestimation gaya. Pada KDS D ke atas, analisis dinamis wajib untuk struktur 

irregular atau tinggi, dengan verifikasi partisipasi massa minimal 90%. 

 

Tabel 4.13 

Nilai Cu 

 

 

Tabel 4.14 

Nilai Periode Struktur yang Digunakan 
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Tabel 4.15 

Nilai Periode Getar Struktur (Tx dan Ty) dari ETABS 

 

 

 

Gambar 4.9 Menentukan Periode Getar Struktur 

 

2. Perhitungan Berat Seismik Efektif 

Perhitungan berat seismik efektif (W) menurut SNI 1726:2019 merupakan 

bagian penting dalam analisis desain tahan gempa untuk struktur bangunan 

gedung dan nongedung, sebagaimana diatur pada Pasal 7.7.2. Berat seismik 

efektif ini mewakili massa struktur yang berkontribusi terhadap inersia selama 

guncangan gempa, digunakan untuk menghitung gaya geser dasar seismik (V) 

melalui rumus V = Cs*W, di mana Cs adalah koefisien respons seismik. 

Tujuannya adalah memperkirakan beban lateral seismik secara akurat, 

memastikan struktur dapat menahan gempa desain dengan probabilitas terlampaui 

2% dalam 50 tahun (MCER). Perhitungan ini mempertimbangkan kombinasi 

beban mati dan sebagian beban hidup yang kemungkinan hadir saat gempa terjadi, 

sesuai dengan adaptasi dari ASCE 7-16. 

Implikasi dari perhitungan berat seismik efektif ini adalah peningkatan 

ketahanan struktur terhadap gempa, terutama di wilayah seismik tinggi Indonesia, 

dengan integrasi ke metode analisis seperti statik ekivalen atau response 

spectrum. Kesalahan dalam estimasi W dapat menyebabkan underdesign atau 

overdesign, sehingga direkomendasikan verifikasi melalui software ETABS. SNI 

1726:2019 juga merujuk pada standar terkait seperti SNI 2847:2019 untuk beton, 

memastikan konsistensi desain. Penggunaan aplikasi Desain Spektra Indonesia 

membantu dalam menentukan parameter pendukung, ultimately mendukung 

prinsip risk-targeted design. 
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Gambar 4.10 Ketentuan Berat Seismik Efektif 

(Sumber: Pasal 7.7.2 SNI 1726:2019) 

 

Jangan lupa untuk menyesuaikan satuan/unit yang akan digunakan untuk 

menampilkan massa tiap lantai. 

 

 

Gambar 4.11 Menyesuaikan Penggunaan Satuan 

 

Setelah itu kita harus melakukan running pada model kita dengan 

menekan tombol F5. Lalu cara untuk mendapatkan berat seismik efektif dari 

software ETABS adalah dengan klik Ctrl + T → Model Definition → Other 

Definitions → Mass Data → Mass Summary by Story. 
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Gambar 4.12 Choose Tables for Display 

 

Tabel 4.16 

Mass Summary by Story 
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Tabel 4.17 

Perhitungan Berat Seismik Efektif 

 

 

Perlu diketahui bahwa massa yang dihitung hanya massa lantai 2 sampai 

26 saja, sedangkan massa lantai dasar tidak perlu dihitung. 

3. Penentuan Base Shear dan Distribusi Gaya Lateral 

Distribusi gaya lateral menurut SNI 1726:2019 dilakukan untuk membagi 

gaya geser dasar seismik (base shear, V) ke setiap tingkat struktur berdasarkan 

karakteristik dinamiknya, seperti periode fundamental (T), tinggi struktur, dan 

distribusi massa. Prosedur ini mengacu pada Pasal 7.8.1 dan 7.8.1.1 SNI 

1726:2019, yang diadaptasi dari ASCE 7-16, dan biasanya menggunakan metode 

statik ekivalen untuk struktur sederhana atau analisis dinamis untuk struktur 

kompleks. 

 

 

Gambar 4.13 Persamaan Gaya Geser Dasar Seismik 
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Gambar 4.14 Persamaan Koefisien Respons Seismik 

 

Tabel 4.18 

Perhitungan Gaya Geser Dasar Seismik 

 

 

Untuk memunculkan diagram distribusi gaya lateral pada ETABS adalah 

dengan cara klik menu Display → Story Respons Plots. 

 

 

Gambar 4.15 Display Story Respons Plots 
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Setelah itu, kita memilih pada opsi Show → Auto Lateral Loads to Diaphs, 

lalu opsi Load Pattern pilih yang SE-X dan SE-Y. 

 

Tabel 4.19 

Memunculkan Gaya Auto Lateral 

 

 

 

Gambar 4.16 Auto Lateral Load to Diaphragm D1 (Load Pattern SE-X) 
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Gambar 4.17 Auto Lateral Load to Diaphragm D1 (Load Pattern SE-Y) 

 

4. Penskalaan Gaya 

Faktor skala awal, sebagaimana diatur dalam SNI 1726:2019 pasal 7.9.1.2, 

merujuk pada koefisien yang digunakan untuk menyesuaikan spektrum respons 

desain awal dalam analisis spektrum respons ragam (response spectrum analysis). 

Faktor ini diterapkan untuk memastikan bahwa hasil analisis mencerminkan 

karakteristik dinamik struktur bangunan secara realistis, dengan 

mempertimbangkan efek nonlinier dan faktor redaman (damping) yang sesuai 

dengan ketentuan standar. Dalam konteks ini, faktor skala awal bertujuan untuk 

menyesuaikan gaya-gaya seismik yang dihitung agar sesuai dengan gaya desain 

minimum yang ditetapkan dalam prosedur gaya lateral ekivalen, sebagaimana 

dijelaskan pada pasal-pasal terkait dalam SNI 1726:2019. 

Penerapan faktor skala awal ini sangat penting dalam desain seismik 

bangunan, terutama untuk struktur dengan karakteristik dinamik yang kompleks. 

Dengan memastikan bahwa gaya geser dasar tidak jatuh di bawah ambang batas 

tertentu, SNI 1726:2019 pasal 7.9.1.2 membantu para insinyur dalam merancang 

bangunan yang mampu menahan guncangan gempa dengan lebih baik. Selain itu, 

penggunaan faktor skala awal juga memperhitungkan variasi kondisi situs dan 

parameter seismik lainnya, seperti percepatan spektral desain (SDS dan SD1), 
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yang diatur dalam pasal-pasal sebelumnya, sehingga desain tetap sesuai dengan 

kondisi geoteknik dan seismik setempat. 

Sebelum melakukan penskalaan gaya (biasanya dilakukan setelah terlebih 

dahulu melakukan running pada ETABS), kita harus mengetahui faktor skala 

awal yang harus dimasukkan pada bagian load cases di ETABS. Pada umumnya 

dilakukan pada gaya gempa dinamik/response spectrum. Untuk mengetahui 

berapa nilai faktor skala awal bisa dilihat pada SNI 1726:2019 Pasal 7.9.1.2. 

 

 

Gambar 4.18 Pasal 7.9.1.2 SNI 1726:2019 

 

Setelah itu, kita harus menghitung besar nilai faktor skala awalnya 

berdasarkan referensi tersebut di atas, biasanya menggunakan rumus g/(R/I), 

dengan g adalah nilai gravitasi 9806,65 mm/s2 atau 9.80665 m/s2. Di bawah ini 

adalah hasil perhitungan faktor skala awal dengan nilai I dan R telah ditunjukkan 

pada Tabel 4.1. 

 

Tabel 4.20 

Perhitungan Faktor Skala Awal 

 

 

Lalu kita bisa memasukkan angka tersebut pada software ETABS. 

Caranya adalah dengan klik menu Define → Load Cases → Add New Case, lalu 

berikan nama RS - X Uns dani RS - Y Uns karena belum diskalakan (unscale). 
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Gambar 4.19 Define Load Cases 

 

 

Gambar 4.20 Add New Cases 
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Gambar 4.21 Load Cases Data for RS -X Uns 
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Gambar 4.22 Load Cases Data for RS -Y Uns 

 

 Setelah kita memasukkan nilai faktor skala awal dan telah melakukan 

semua penginputan beban, selanjutnya kita harus melakukan pengecekan struktur 

bangunan yang telah dimodelkan. Caranya adalah dengan klik menu Analyze → 

Check Model → Length Tolerance for Checks 0.00000000001 mm → Centang 

Semua → klik OK. Langkah ini adalah langkah penting sebelum kita melakukan 

desain penulangan pelat lantai, balok, kolom, dan shear wall. Lakukan seperti 

yang ditunjukkan gambar di bawah. 
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Gambar 4.23 Check Model 

 

Pastikan tidak ada warning message setelah kita melakukan check model 

tersebut. Dan jika ada warning message, maka kita harus memperbaiki desain kita. 

 

 

Gambar 4.24 No Warning Message After Doing Check Model 

 

Lalu kita melakukan running terhadap struktur gedung yang telah 

dimodelkan dengan cara menekan tombol F5 dan tunggu sampai program selesai 

melakukan running. Pastikan hasil struktur yang telah didesain “aman”. 

Berikutnya kita akan melakukan cek terhadap gaya geser dasar statik dan dinamik 
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yang telah kita desain. Caranya adalah klik CTRL + T → Analysis Results → 

Structure Output → Base Reactions → Table: Base Reactions. Di bawah ini 

adalah gambar tabel yang akan ditampilkan. 

 

 

Gambar 4.25 Hasil Concrete Frame Design 

 

 

Gambar 4.26 Choose Table for Display 
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Gambar 4.27 Select Load Patterns 

 

 

Gambar 4.28 Set Load Cases Selection 
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Gambar 4.29 Set Combo Selection 

 

Tabel 4.21 

Gaya Geser Dasar/Base Reactions yang Belum Diskalakan 

 

 

Bisa dilihat pada tabel di atas bahwa hasil gaya geser statiknya (SE) lebih 

besar dari pada gaya geser dinamik yang belum diskalakan (RS Uns), baik arah X 

maupun arah X. 

• SE – X  = -19989.2432 kN 

• SE – Y  = -21834.5261 kN 

• RS – X Uns = 11496.1549 kN 

• RS – Y Uns = 12331.8565 kN 

Berdasarkan tabel di atas, itu sudah memenuhi syarat untuk melakukan 

penskalaan untuk faktor skala yang baru sesuai dengan SNI 1726:2019 Pasal 

7.9.2.5.2. 
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Gambar 4.30 Penentuan Faktor Skala Untuk Gaya Geser Dasar 

 

Penskalaan gaya menurut SNI 1726:2019 dilakukan untuk memastikan 

hasil analisis dinamis (seperti metode respons spektrum) sesuai dengan gaya geser 

dasar minimum yang ditentukan oleh metode statik ekivalen, sebagaimana diatur 

dalam Pasal 7.9.1.4.1. Prosedur ini diadopsi dari ASCE 7-16 untuk menjamin 

desain struktur aman terhadap beban seismik, terutama pada Kategori Desain 

Seismik (KDS) D, E, atau F, di mana analisis dinamis sering kali diwajibkan. 

 

 

Gambar 4.31 Penskalaan Gaya 

 

Tabel 4.22  

Perhitungan Penskalaan Gaya 
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Bisa dilihat bahwa faktor skala yang baru adalah 2435.94 mm/s2 untuk 

arah X dan  1704.41 mm/s2 untuk arah Y. Dan nilai itu kita masukkan lagi ke 

dalam load cases response spectrum yang sudah diskalakan (scaled). Caranya 

sama seperti membuat load cases, yaitu klik Define → Load Cases → Add New 

Case, namun berikan namanya RS - X Scaled dan RS - Y Scaled. Di bawah ini 

adalah gambar dari pembuatan RS - X Scaled dan RS - Y Scaled. 

 

 

Gambar 4.32 Load Cases Data for RS -X Scaled 
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Gambar 4.33 Load Cases Data for RS -Y Scaled 

 

Setelah melakukan penginputan faktor skala yang baru, kita harus 

melakukan running ulang pada model yang telah dibuat. Setelah itu, kembali buka 

tabel gaya geser dasar untuk statik dan dinamik, namun kali ini untuk gaya gempa 

dinamik yang telah diskalakan. Di bawah ini adalah tabel base reaction untuk 

gaya geser statik dan dinamik yang telah diskalakan. 

 

Tabel 4.23 

Gaya Geser Dasar/Base Reactions yang Telah Diskalakan 
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Bisa dilihat pada tabel di atas bahwa hasil gaya geser statiknya (SE) lebih 

besar dari pada gaya geser dinamik yang belum diskalakan (RS Uns), baik arah X 

maupun arah X. 

• SE – X  = -19989.2432 kN 

• SE – Y  = -21834.5261 kN 

• RS – X Scaled = 19989.2527 kN 

• RS – Y Scaled = 21834.6258 kN 

Berdasarkan tabel di atas, itu sudah memenuhi syarat untuk melakukan 

penskalaan untuk faktor skala yang baru sesuai dengan SNI 1726:2019 Pasal 

7.9.2.5.2. 

5. Torsi Bawaan dan Torsi Tak Terduga 

Torsi bawaan, sebagaimana diatur dalam SNI 1726:2019, merujuk pada 

momen puntir yang timbul pada struktur bangunan akibat ketidaksesuaian antara 

pusat massa dan pusat kekakuan pada setiap tingkat lantai. Fenomena ini terjadi 

ketika gaya gempa yang bekerja pada pusat massa menghasilkan efek puntiran 

karena adanya eksentrisitas, yaitu jarak antara pusat massa dan pusat kekakuan. 

Dalam desain seismik, torsi bawaan menjadi pertimbangan penting untuk 

memastikan bahwa elemen struktur, terutama pada bangunan dengan konfigurasi 

denah tidak beraturan, dapat menahan tegangan tambahan akibat puntiran, 

sehingga mencegah kerusakan lokal pada komponen seperti kolom atau dinding 

geser. 

Dalam prosedur analisis gaya lateral ekivalen, torsi bawaan dihitung 

dengan mengalikan gaya lateral pada setiap tingkat lantai dengan eksentrisitas 

desain, menghasilkan momen puntir yang harus didistribusikan ke elemen 

penahan gempa seperti dinding geser atau rangka. SNI 1726:2019 menekankan 

bahwa distribusi torsi ini harus mempertimbangkan kekakuan relatif dari elemen 

struktur agar gaya puntir terbagi secara proporsional. Untuk bangunan dengan 

ketidakaturan puntir ekstrem, standar ini merekomendasikan analisis dinamik 

tambahan untuk memastikan bahwa efek torsi bawaan tidak menyebabkan 

deformasi berlebihan atau kegagalan struktur. 

Untuk diafragma yang tidak fleksibel, distribusi gaya lateral di masing-

masing tingkat harus memperhitungkan pengaruh momen torsi bawaan, Mt, 

akibat eksentrisitas antara lokasi pusat massa dan pusat kekakuan. Untuk 

diafragma fleksibel, distribusi gaya ke elemen vertikal harus memperhitungkan 

posisi dan distribusi massa yang didukungnya. 

Torsi tak terduga sebagaimana diatur dalam SNI 1726:2019, merujuk pada 

momen puntir tambahan yang diperhitungkan dalam desain seismik untuk 
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mengakomodasi ketidakpastian atau ketidaksempurnaan dalam distribusi massa 

dan kekakuan struktur bangunan. Torsi ini timbul akibat eksentrisitas tak sengaja 

(accidental eccentricity), yang diasumsikan terjadi meskipun struktur dirancang 

dengan pusat massa dan pusat kekakuan yang sejajar. Ketentuan ini penting untuk 

memastikan bahwa bangunan tetap aman terhadap efek puntiran yang tidak 

terantisipasi selama gempa, terutama pada bangunan dengan denah tidak 

beraturan atau kompleks dan harus memenuhi SNI 1726:2019 Tabel 13. 

Jika diafragma tidak fleksibel, desain harus menyertakan momen torsi 

bawaan (Mt) yang dihasilkan dari lokasi massa struktur ditambah momen torsi tak 

terduga (Mta) akibat perpindahan pusat massa dari lokasi aktualnya yang 

diasumsikan pada masing-masing arah dengan jarak sebesar 5% dimensi struktur 

tegak lurus terhadap arah gaya yang diterapkan. 

 

Tabel 4.24 

Ketidakberaturan Horizontal pada Struktur 

 

 

Jika gaya gempa diterapkan secara serentak dalam dua arah ortogonal, 

perpindahan pusat massa 5% yang disyaratkan tidak perlu diterapkan dalam kedua 
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arah ortogonal pada saat bersamaan, tetapi harus diterapkan dalam arah yang 

menghasilkan pengaruh yang lebih besar. 

Torsi tak terduga harus diaplikasikan ke semua struktur untuk menentukan 

keberadaan ketidakberaturan horizontal seperti yang diatur pada Tabel 13. 

Momen torsi tak terduga (Mta) tidak perlu diperhitungkan pada saat menentukan 

gaya seismik E pada perencanaan struktur dan pada saat menentukan simpangan 

antar tingkat desain seperti pada pasal 7.8.6, 7.9.1.2 atau pasal 11.1.2, atau pada 

saat menentukan batasan-batasan pada pasal 7.12.1, kecuali untuk struktur-

struktur berikut: 

a. Struktur dengan kategori desain seismik B dengan ketidakberaturan struktur 

horizontal tipe 1b; dan 

b. Struktur dengan kategori desain seismik C, D, E dan F dengan 

ketidakberaturan struktur horizontal tipe 1a atau 1b. 

Pembesaran momen torsi tak terduga pada struktur yang didesain untuk 

kategori desain seismik C, D, E, atau F, di mana ketidakberaturan torsi tipe 1a 

atau 1b terjadi seperti didefinisikan dalam Tabel 13 harus mempunyai pengaruh 

yang diperhitungkan dengan mengalikan Mta di masing-masing tingkat dengan 

faktor pembesaran torsi (Ax) seperti digambarkan dalam Gambar 9 dan ditentukan 

dari persamaan berikut. 

Ax = (δmax/1,2 δavg)2 

Keterangan: 

δ max  = perpindahan maksimum di tingkat x (mm) 

δ avg  = rata-rata perpindahan di titik-titik terjauh struktur di tingkat x 

Ax  = Faktor pembesaran torsi diasumsikan nilainya 1 mm 

Faktor pembesaran torsi (Ax) tidak boleh kurang dari 1 dan tidak perlu 

melebihi 3. Pembebanan yang lebih parah untuk masing-masing elemen harus 

ditinjau untuk desain. 

6. Pengecekan Simpangan Antar Tingkat 

Simpangan antar tingkat, sebagaimana diatur dalam SNI 1726:2019, 

merujuk pada perbedaan perpindahan lateral relatif antara dua tingkat lantai 

berurutan pada struktur bangunan akibat beban gempa. Parameter ini penting 

untuk mengevaluasi kinerja seismik bangunan, karena simpangan antar tingkat 

yang berlebihan dapat menyebabkan kerusakan pada elemen struktur, seperti 

kolom atau dinding, serta elemen nonstruktural, seperti partisi atau fasad. Dalam 

SNI 1726:2019, khususnya pada Tabel 20, simpangan antar tingkat dihitung untuk 

memastikan bahwa deformasi struktur tetap dalam batas aman, sehingga 

mencegah keruntuhan atau kerusakan signifikan selama gempa. 
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Menurut SNI 1726:2019, simpangan antar tingkat dihitung berdasarkan 

hasil analisis struktur, baik menggunakan metode gaya lateral ekivalen, analisis 

spektrum respons ragam, maupun analisis riwayat waktu. Simpangan ini diukur 

sebagai selisih perpindahan lateral (δ) antara dua tingkat lantai berurutan, dibagi 

dengan tinggi lantai (h), dan dinyatakan sebagai rasio simpangan antar tingkat 

(drift ratio). 

Penentuan simpangan antar tingkat desain () harus dihitung sebagai 

perbedaan simpangan pada pusat massa di atas dan di bawah tingkat yang ditinjau. 

Apabila pusat massa tidak segaris dalam arah vertikal, diizinkan untuk 

menghitung simpangan di dasar tingkat berdasarkan proyeksi vertikal dari pusat 

massa tingkat di atasnya. Jika desain tegangan izin digunakan,  harus dihitung 

menggunakan gaya seismik desain yang ditetapkan dalam Pasal 7.8.1 SNI 

1726:2019 tanpa reduksi untuk desain tegangan izin. 

 

 

Gambar 4.34 Penentuan Simpangan Antar Tingkat 

 

Bagi struktur yang didesain untuk kategori desain seismik C, D, E atau F 

yang memiliki ketidakberaturan horizontal Tipe 1a atau 1b pada Tabel 13, 

simpangan antar tingkat desain, , harus dihitung sebagai selisih terbesar dari 

simpangan titik-titik yang segaris secara vertikal di sepanjang salah satu bagian 

tepi struktur, di atas dan di bawah tingkat yang ditinjau. 
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Simpangan pusat massa di tingkat-x (x) (mm) harus ditentukan sesuai 

dengan persamaan berikut: 

δ = (Cd*δxe)/Ie 

Keterangan: 

Cd = faktor pembesaran simpangan lateral dalam Tabel 12 

δxe = simpangan di tingkat x yang diisyaratkan pada pasal 7.8.6, dengan 

analisis elastik 

Ie  = faktor keutamaan gempa 

 

Tabel 4.25 

Simpangan Antar Tingkat Izin 

 

(Sumber: Tabel 20 SNI 1726:2019) 

 

Setelah kita mengetahui syarat-syarat untuk simpangan antar tingkat, 

maka selanjutnya adalah mendapatkan nilai simpangan antar tingkat pada 

software ETABS. Caranya adalah klik Display → Story Response Plots. 
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Gambar 4.35 Display Story Response Plots 

 

 

Gambar 4.36 RS – X Unscale Diaphragma Center of Mass Displacement 
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Gambar 4.37 RS – Y Unscale Diaphragma Center of Mass Displacement 

 

 

Grafik 4.1 Hasil Pengecekan Simpangan Antar Tingkat 
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Tabel 4.26 

Simpangan Antar Tingkat 

 

 

7. Pengecekan Pengaruh P-Delta 

Dalam SNI 1726:2019, P-Delta, merujuk pada efek orde kedua dalam 

analisis struktur bangunan akibat interaksi antara beban gravitasi (P) dan 

simpangan lateral (Δ) yang diinduksi oleh gaya gempa. Efek ini menyebabkan 

momen tambahan pada elemen struktur karena beban vertikal bertindak pada 

posisi yang telah bergeser secara lateral, sehingga memperburuk deformasi dan 

meningkatkan gaya internal seperti momen dan geser. Dalam desain seismik, 

pengaruh P-Delta harus diperhitungkan untuk memastikan stabilitas struktur, 

terutama pada bangunan tinggi atau fleksibel di wilayah rawan gempa seperti 

Indonesia, karena dapat menyebabkan ketidakstabilan jika tidak diatasi dengan 

benar. 
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Ketentuan ini diterapkan pada semua analisis struktur, baik metode gaya 

lateral ekivalen maupun analisis dinamik, dan wajib untuk bangunan dengan 

periode fundamental lebih dari 1,2 detik atau dengan rasio kekakuan yang rendah. 

SNI 1726:2019 menekankan bahwa pengaruh P-Delta juga memengaruhi 

simpangan antar tingkat, sehingga simpangan desain harus disesuaikan jika efek 

ini signifikan. Untuk bangunan dengan ketidakaturan vertikal, evaluasi P-Delta 

menjadi lebih kritis untuk mencegah konsentrasi deformasi pada tingkat tertentu, 

dan analisis nonlinier mungkin diperlukan jika θ mendekati 0,25, di mana struktur 

dianggap tidak stabil. 

Penerapan pengaruh P-Delta dalam SNI 1726:2019 bertujuan untuk 

meningkatkan ketahanan seismik bangunan dengan mempertimbangkan efek 

realistis selama gempa. Dengan memperhitungkan interaksi ini, insinyur dapat 

merancang struktur yang lebih kaku, seperti menambahkan dinding geser atau 

memperbesar dimensi elemen, untuk mengurangi simpangan lateral dan 

mencegah keruntuhan progresif. Ketentuan ini selaras dengan standar 

internasional seperti ASCE 7-16, dan sangat relevan di Indonesia untuk 

meminimalkan kerusakan akibat gempa besar. Oleh karena itu, pemahaman 

pengaruh P-Delta menjadi elemen esensial dalam desain struktur yang aman dan 

tahan lama. 

 ϴ = (Px*Δ*Ie)/(Vx*hsx*Cd) 

Keterangan: 

 

 

 

Untuk mengetahui nilai P-Delta berdasarkan software ETABS, terlebih 

dahulu melakukan running terhadap model struktur gedung yang telah kita buat. 

Setelah dilakukan running, klik Ctrl + T → Analysis Results → Structure Output 

→ Other Output Items → Story Forces seperti ditunjukkan gambar di bawah. 
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Gambar 4.38 Choose Tables for Display 

 

 

Gambar 4.39 Set Load Case Selection 
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Gambar 4.40 Set Combo Selection 
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Setelah muncul tabel story forces, langkah selanjutnya adalah dengan klik 

kanan pada kolom Output Case → Service dan Location → Top. Kemudian salin 

beban P dari lantai 26 sampai lantai 2 ke dalam sheet Excel yang sudah dibuat 

berdasarkan rumus SNI di atas untuk menghitung P-Delta. 
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Tabel 4.29 

Input Nilai P 

 

 

Cara yang sama dilakukan untuk memasukkan nilai Vx dan Vy ke dalam 

sheet Excel yang telah dibuat. Akan tetapi, pada kolom Output Case diganti 

dengan RS – X Scaled dan RS – Y Scaled. 
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Salin beban RS – X Scaled (VX) dan RS – Y Scaled (VY) dari lantai 26 

sampai lantai 2 ke dalam sheet Excel yang sudah dibuat berdasarkan rumus SNI 

di atas untuk menghitung P-Delta. 

 

Tabel 4.32 

Hasil Perhitungan P-Delta 
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Grafik 4.2 Hasil Pengecekan Pengaruh P-Delta 

 

8. Pengecekan Ketidakberaturan Horizontal 

Ketidakberaturan horizontal dalam konteks perencanaan ketahanan gempa 

mengacu pada kondisi struktur bangunan gedung atau nongedung yang 

menunjukkan ketidakmerataan distribusi massa, kekakuan, atau kekuatan secara 

horizontal, sehingga dapat menimbulkan respons seismik yang tidak seragam. 

Menurut Tabrl 13 SNI 1726:2019, ketidakberaturan ini diklasifikasikan untuk 

memastikan bahwa desain struktur memperhitungkan potensi peningkatan beban 

gempa akibat ketidakberaturan tersebut. Klasifikasi ini bertujuan untuk mencegah 

kerusakan berlebih pada elemen struktural selama kejadian gempa, dengan 

menekankan analisis yang lebih ketat pada struktur yang termasuk dalam kategori 

desain seismik tertentu. Ketidakberaturan horizontal sering kali terjadi pada 

bangunan dengan bentuk denah tidak simetris, seperti bentuk L, T, atau U, yang 

dapat menyebabkan torsi atau deformasi tidak merata. 
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Tabel 4.33 

Ketidakberaturan Horizontal 
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Gambar 4.41 Bentuk-Bentuk Ketidakberaturan Horizontal 
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Gambar 4.42 Denah Gedung Kantor 26 Lantai 

 

a. Ketidakberaturan torsi 

Untuk melakukan pengecekan ketidakberaturan torsi, terlebih dahulu 

kita harus mengetahui nilai rasio antar tingkatnya. Caranya adalah klik Ctrl + 

T → Analysis Results → Joint Output → Displacement → Table: Story Max 

Over Avg Drift → pilih Load Pattern RS – X, RS – Y, SE – X dan SE – Y → 

pilih Load Cases RS – X Scaled, RS – Y Scaled, SE – X dan SE – Y → OK. 

Lalu klik kanan pada kolom Output Case → RS – X Scaled dan juga RS – Y 

Scaled. 
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Tabel 4.34 

Story Max Over Avg Drift on RS – X Scaled 
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Tabel 4.35 

Story Max Over Avg Drift on RS – Y Scaled 
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Tabel 4.36 

Pengecekan Ketidakberaturan Torsi 

 

 

Dapat disimpulkan dari hasil perhitungan pada tabel di atas, diketahui 

bahwa struktur gedung kantor ini TIDAK MEMILIKI 

KETIDAKBERATURAN TORSI 1a DAN 1b. 

b. Ketidakberaturan sudut dalam 

Untuk mengetahui apakah struktur yang kita desain memiliki 

ketidakberaturan sudut dalam atau tidak, maka kita harus menghitung secara 

manual menggunakan Excel dengan mengacu pada SNI 1726:2019 Tabel 13. 
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Gambar 4.43 Lx dan Px pada Ketidakberaturan Sudut Dalam 

 

Tabel 4.37  

Pengecekan Ketidakberaturan Sudut Dalam 

 

 

Dilihat dari hasil perhitungan di atas, diketahui bahwa struktur gedung 

ini MEMILIKI KETIDAKBERATURAN SUDUT DALAM. 

c. Ketidakberaturan diskontinuitas diafragma 

Cara untuk mengetahui ketidakberaturan diskontinuitas diafragma 

adalah dengan membagi luasan bukaan dengan luasan total lantai. 
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Gambar 4.44 Penentuan Luasan Bukaan 

 

Tabel 4.38 

Pengecekan Ketidakberaturan Diskontinuitas Diafragma 

 

 

Dilihat dari hasil perhitungan di atas, diketahui bahwa struktur gedung 

ini TIDAK MEMILIKI KETIDAKBERATURAN DISKONTINUITAS 

DIAFRAGMA. 

d. Ketidakberaturan akibat pergeseran tegak lurus terhadap bidang 

Didefinisikan ada jika terdapat diskontinuitas dalam lintasan tahanan 

gaya lateral, seperti pergeseran tegak lurus terhadap bidang pada setidaknya 

satu elemen vertikal pemikul gaya lateral. Misalnya terdapat kolom atau shear 

wall tumbuh. Jika dilihat dari denah dan portal, struktur gedung ini TIDAK 
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MEMILIKI KETIDAKBERATURAN AKIBAT PERGESERAN 

TEGAK LURUS TERHADAP BIDANG. 

e. Ketidakberaturan sistem nonparalel 

Didefinisikan ada jika elemen vertikal pemikul gaya lateral tidak 

paralel terhadap sumbu-sumbu ortogonal utama sistem pemikul gaya seismik. 

Jika dilihat dari denah dan portal, struktur gedung ini TIDAK MEMILIKI 

KETIDAKBERATURAN SISTEM NONPARALEL. 

9. Pengecekan Ketidakberaturan Vertikal 

Ketidakberaturan vertikal dalam perencanaan ketahanan gempa merujuk 

pada kondisi struktur bangunan gedung atau nongedung yang menunjukkan 

ketidakmerataan distribusi kekakuan, massa, geometri, atau kekuatan secara 

vertikal, yang dapat menyebabkan respons seismik tidak seragam dan 

meningkatkan risiko kerusakan selama gempa. Menurut Tabel 14 SNI 1726:2019, 

ketidakberaturan ini diklasifikasikan untuk memastikan bahwa desain struktur 

memperhitungkan potensi amplifikasi beban gempa akibat variasi tersebut, 

khususnya pada kategori desain seismik yang lebih tinggi. Klasifikasi ini 

bertujuan untuk mencegah kegagalan progresif pada tingkat-tingkat bangunan, 

dengan menekankan analisis yang lebih mendalam seperti analisis modal atau 

time history pada struktur yang teridentifikasi tidak beraturan. Ketidakberaturan 

vertikal sering muncul pada bangunan dengan perubahan signifikan pada elevasi, 

seperti penurunan kekakuan pada tingkat dasar atau penambahan massa pada 

lantai atas, yang dapat memicu konsentrasi deformasi. 

Ketidakberaturan vertikal dibagi menjadi beberapa tipe, di antaranya tipe 

1a atau ketidakberaturan kekakuan tingkat lunak, yang terjadi ketika kekakuan 

lateral suatu tingkat kurang dari 70% kekakuan tingkat di atasnya atau kurang dari 

80% kekakuan rata-rata tiga tingkat di atasnya. Tipe 1b, yaitu ketidakberaturan 

kekakuan tingkat lunak berlebihan, didefinisikan ketika kekakuan lateral tingkat 

tersebut kurang dari 60% kekakuan tingkat di atasnya atau kurang dari 70% 

kekakuan rata-rata tiga tingkat di atasnya. 
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Tabel 4.39 

Ketidakberaturan Vertikal 
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Gambar 4.45 Bentuk-Bentuk Ketidakberaturan Vertikal 
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Gambar 4.46 Portal Bangunan 

 

a. Ketidakberaturan kekakuan tingkat lunak 

Untuk melakukan pengecekan ketidakberaturan torsi, terlebih dahulu 

kita harus mengetahui nilai rasio antar tingkatnya. Caranya adalah klik Ctrl + 

T → Analysis Results → Structure Output → Other Output Items → Table: 

Story Stiffness → pilih Load Pattern RS – X, RS – Y, SE – X dan SE – Y → 

pilih Load Cases RS – X Scaled, RS – Y Scaled, SE – X dan SE – Y → OK. 

Lalu klik kanan pada kolom Output Case → RS – X Scaled dan juga RS – Y 

Scaled. 
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Tabel 4.40 

Story Stiffness on RS – X Scaled 
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Tabel 4.41 

Story Stiffness on RS – Y Scaled 
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Tabel 4.42 

Pengecekan Ketidakberaturan Kekakuan Tingkat Lunak 

 

 

Dapat disimpulkan dari hasil perhitungan pada tabel di atas, diketahui 

bahwa struktur gedung kantor ini TIDAK MEMILIKI 

KETIDAKBERATURAN KEKAKUAN. TINGKAT LUNAK 1a DAN 

1b. 

b. Ketidakberaturan massa 

Untuk melakukan pengecekan ketidakberaturan torsi, terlebih dahulu 

kita harus mengetahui nilai rasio antar tingkatnya. Caranya adalah klik Ctrl + 

T → Model Definition→ Other Definition → Mass Data → Table: Mass 

Summary by Story → pilih Load Pattern RS – X, RS – Y, SE – X dan SE – Y 

→ pilih Load Cases RS – X Scaled, RS – Y Scaled, SE – X dan SE – Y → OK. 

Lalu klik kanan pada kolom Output Case → RS – X Scaled dan juga RS – Y 

Scaled. 
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Gambar 4.47 Choose Table for Display 
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Tabel 4.43  

Mass Summary by Story 

 

 

Lalu salin data UX atau UY ke dalam sheet Excel yang telah dibuat 

berdasarkan SNI 1726:2019 Tabel 14. 
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Tabel 4.44 

Pengecekan Ketidakberaturan Massa 

 

 

Dapat disimpulkan dari hasil perhitungan pada tabel di atas, diketahui 

bahwa struktur gedung kantor ini MEMILIKI KETIDAKBERATURAN 

MASSA. 

c. Ketidakberaturan geometri vertikal 

Untuk mengetahui apakah struktur kita memiliki ketidakberaturan 

geometri vertikal, biasanya kembalikan model ke bentuk 3 dimensi dengan 

klik ikon 3d pada ETABS. Setelah itu, cek dimensi kolom yang digunakan 

mulai dari lantai dasar sampai lantai 26. Caranya klik kanan pada salah satu 

kolom di model kita lalu lihat pada bagian Assignments → Section Property. 

Dilihat dari gambar di bawah, dapat disimpulkan bahwa ukuran kolom yang 

digunakan pada lantai dasar adalah kolom 1400 x 1400. Lalu lakukan cara 

yang sama untuk memeriksa ukuran kolom yang digunakan di lantai atasnya. 
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Gambar 4.48 Column Information 

 

Siapkan sheet Excel yang telah dibuat berdasarkan Tabel 14 SNI 

1726:2019, lalu salin masing-masing ukuran kolom pada tiap lantainya 

(kecuali lantai dak). 
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Tabel 4.45 

Pengecekan Ketidakberaturan Geometri Vertikal 

 

 

Dapat disimpulkan dari hasil perhitungan pada tabel di atas, diketahui 

bahwa struktur gedung kantor ini MEMILIKI KETIDAKBERATURAN 

GEOMETRI VERIKAL. 

d. Ketidakberaturan akibat diskontinuitas bidang pada elemen vertikal 

Untuk mengetahui apakah struktur kita memiliki ketidakberaturan 

akibat diskontinuitas bidang, salah satunya dapat dilihat melalui portal 

bangunan. Berdasarkan portal bangunan, struktur gedung ini TIDAK 

MEMILIKI KETIDAKBERATURAN AKIBAT DISKONTINUITAS 

BIDANG karena tidak ada shear wall yang tumbuh di lantai atasnya maupun 

pergeseran posisi shear wall pada satu lantai. 

e. Ketidakberaturan tingkat lemah berlebihan 

Untuk melakukan pengecekan ketidakberaturan torsi, terlebih dahulu 

kita harus mengetahui nilai rasio antar tingkatnya. Caranya adalah klik Ctrl + 

T → Analysis Results → Structure Output → Other Output Items → Table: 
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Story Forces → pilih Load Pattern RS – X, RS – Y, SE – X dan SE – Y → 

pilih Load Cases RS – X Scaled, RS – Y Scaled, SE – X dan SE – Y → OK. 

Lalu klik kanan pada kolom Output Case → RS – X Scaled dan juga RS – Y 

Scaled, dan Location pilih Top. Kemudian salin nilai VX dan VY ke dalam 

sheet Excel. 

 

 

Gambar 4.49 Choose Table for Display 
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Tabel 4.46 

RS – X Scaled Story Forces 
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Tabel 4.47  

RS – Y Scaled Story Forces 
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Tabel 4.48 

Pengecekan Ketidakberaturan Tingkat Lemah 

 

 

Dapat disimpulkan dari hasil perhitungan pada tabel di atas, diketahui 

bahwa struktur gedung kantor ini TIDAK MEMILIKI 

KETIDAKBERATURAN TINGKAT LEMAH. 

10. Penentuan Fleksibilitas Diafragma 

Penentuan fleksibilitas diafragma dalam perencanaan struktur bangunan 

merupakan aspek penting untuk memastikan distribusi gaya seismik yang tepat, 

khususnya dalam menghadapi beban gempa. Menurut SNI 1726:2019 Pasal 7.3.1, 

fleksibilitas diafragma ditentukan berdasarkan kekakuan relatif diafragma 

terhadap elemen vertikal sistem pemikul gaya lateral, di mana analisis struktur 

harus memperhitungkan interaksi ini untuk menghindari asumsi yang tidak akurat. 

Diafragma dapat diklasifikasikan sebagai fleksibel dan kaku, tergantung pada 

perbandingan simpangan maksimum di tengah bentang diafragma dengan 

simpangan rata-rata pada penyangga vertikal. Klasifikasi ini memengaruhi 

metode analisis seismik yang digunakan, seperti apakah diafragma dapat 

diidealkan sebagai kaku untuk distribusi gaya torsional atau memerlukan 

pemodelan lebih detail jika fleksibel. 
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Diafragma harus didesain untuk tegangan geser dan lentur yang dihasilkan 

dari gaya desain. Pada diskontinuitas diafragma, seperti bukaan dan sudut dalam, 

desain harus menjamin bahwa disipasi atau transfer gaya tepi (kord) terkombinasi 

dengan gaya lainnya dalam diafragma tidak boleh melebihi kapasitas geser dan 

tarik diafragma. Diafragma lantai dan atap harus didesain untuk menahan gaya 

seismik desain dari analisis struktur, tetapi tidak boleh kurang dari yang 

ditentukan sesuai dengan persamaan (51) SNI 1726:2019 Pasal 7.10.1.1 di bawah. 

 

 

Keterangan: 

 

Ada batasan lain setelah mengetahui persamaan gaya desain diafragma, 

yaitu hasil dari Fpx dari persamaan (51) di atas tidak boleh kurang dari Fpx 

persamaan (52) dan tidak boleh melebihi Fpx persamaan (53). 

     

  

Dengan kata lain, jikalau disederhanakan, maka Fpx (52) ≤ Fpx (51) ≤ Fpx 

(53). Gaya desain diafragma (Fpx) diaplikasikan per lantai dan lantai lainnya 

diaplikasikan gaya Fx seperti dianalogikan pada gambar di bawah. 

 

 

Gambar 4.50 Vertical Force Distribution with Diaphragm Force 

(Sumber: NEHRP Seismic Design Technical Brief No.5) 
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Gambar 4.51 Design Forces for Vertical Elements and Diaphragm Force 

(Sumber: NEHRP Seismic Design Technical Brief No.3) 
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Dirunut dari rumus Pasal 7.3.1.1 sampai 7.3.1.3 kita harus menyiapkan 

sheet Excel berdasarkan rumus tersebut di atas. 

 

Tabel 4.50  

Perhitungan Fleksibilitas Diafragma Arah X dengan Meninjau  

Dimensi Diafragma (S/De) 
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Tabel 4.51 

Perhitungan Fleksibilitas Diafragma Arah Y dengan Meninjau  

Dimensi Diafragma (S/De) 

 

 

Dapat dilihat dari kesimpulan yang ada di dalam tabel bahwa fleksibilitas 

ditentukan dengan cara defleksi diafragma. 
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Tabel 4.52 

Perhitungan Fleksibilitas Diafragma Arah X dengan Meninjau  

Defleksi Diafragma 
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Tabel 4.53  

Perhitungan Fleksibilitas Diafragma Arah Y dengan Meninjau Defleksi Diafragma 

 

 

Berdasarkan rekapan yang telah penulis buat, di bawah ini adalah hasil 

perhitungan fleksibilitas diafragma sekaligus menyimpulkan bahwa diafragma 

yang digunakan adalah semi rigid. 

11. Penentuan Tulangan Kord 

Tulangan kord dalam SNI 1726:2019 merujuk pada tulangan tambahan 

yang dirancang untuk menahan gaya tarik dan tekan akibat beban gempa pada 

elemen diafragma horizontal, seperti pelat lantai atau atap, yang berfungsi sebagai 

elemen penyalur gaya lateral ke sistem penahan gempa vertikal. Tulangan kord 

ini ditempatkan di sepanjang tepi diafragma untuk membentuk sistem penahan 

gaya yang efektif, terutama pada struktur dengan bukaan besar atau 
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ketidakberaturan yang memengaruhi distribusi gaya. Ketentuan ini bertujuan 

untuk memastikan bahwa diafragma dapat mentransfer gaya geser dan momen ke 

elemen vertikal seperti kolom atau dinding geser tanpa mengalami kegagalan 

lokal, meningkatkan integritas keseluruhan struktur selama gempa. 

Tulangan kord juga berperan dalam mengatasi efek torsi yang timbul dari 

ketidakberaturan horizontal, seperti sudut reentrant atau diskontinuitas, dengan 

menempatkan tulangan tambahan di sepanjang garis kord untuk menyeimbangkan 

momen. Jarak dan diameter tulangan kord harus disesuaikan dengan panjang 

efektif diafragma dan gaya yang ditransfer, dengan anchorage yang memadai 

untuk mencegah pull-out. Ketentuan ini diintegrasikan dengan analisis dinamis 

jika struktur memiliki periode panjang atau massa tidak merata, memastikan 

bahwa kord dapat menahan beban siklik tanpa kerusakan signifikan. 

Untuk mengetahui berapa jumlah tulangan tambahan tepi yang akan 

dipasang pada diafragma, caranya adalah tinjau salah satu lantainya, lalu klik F9 

→ Case pilih yang SE – X atau SE – Y → Component Mmax → OK. 

 

 

Gambar 4.52 Warna Momen Pelat Lantai 

 

Selanjutnya adalah ke menu Draw → Draw Section Cut, lalu tarik garis 

memanjang pada tepi lantai tersebut. Di bawah ini adalah hasil section cut. 
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Gambar 4.53 Section Cut Forces untuk Tulangan Kord 

 

Gaya tarik yang terjadi adalah 91,35 kN, maka As = Tu/(∅*fy) = 

9.135.000 N/(0,9*420) = 243,39 mm2. Dari hasil As perlu tersebut akan dipasang 

3 buah tulangan D10 mm. Untuk mengetahui batas izin tekan yang terjadi, bisa 

dilihat di Pasal 18.12.7.5 SNI 2847:2019. Diketahui bahwa batas izin tekan adalah 

0,2*fc*Apelat = 0,2*30*(40,-36,24)*1000*125 = 3.503 kN. Jika dibandingkan 

gaya tekan yang terjadi yaitu sebesar 91,35 kN, dengan kata lain gaya tekan tidak 

perlu memenuhi syarat tulangan transversal/pengekang untuk komponen tekan. 

 

 

Gambar 4.54 Detail Pemasangan Tulangan Kord 
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12. Penentuan Tulangan Kolektor 

Tulangan kolektor dalam SNI 1726:2019 merujuk pada elemen tulangan 

tambahan pada diafragma yang dirancang untuk mengumpulkan dan mentransfer 

gaya geser dari elemen nonstruktural atau bagian diafragma ke elemen penahan 

gaya lateral vertikal, seperti kolom atau dinding geser, selama kejadian gempa. 

Fungsi utama kolektor adalah memastikan distribusi gaya yang merata, mencegah 

konsentrasi tegangan yang dapat menyebabkan kegagalan lokal pada sambungan 

atau diafragma itu sendiri. Ketentuan ini khususnya relevan pada struktur dengan 

bukaan besar, ketidakberaturan horizontal, atau diafragma fleksibel, di mana gaya 

perlu dialihkan secara efisien ke sistem penahan utama, meningkatkan ketahanan 

keseluruhan terhadap guncangan seismik. 

Tulangan kolektor ditempatkan di sepanjang jalur yang mengarah ke 

elemen penahan vertikal, sering kali berupa tulangan tambahan yang diperkuat 

dengan pengangkutan yang memadai untuk mencegah slip atau pull-out. Jarak dan 

diameter tulangan harus disesuaikan dengan panjang efektif diafragma dan gaya 

yang ditransfer, dengan detailing yang mencakup sengkang pendamping untuk 

pengekangan tambahan. Ketentuan ini diintegrasikan dengan analisis efek P-Delta 

dan eksentrisitas untuk memastikan bahwa kolektor dapat menahan beban siklik 

tanpa deformasi berlebih, terutama pada struktur tinggi atau tidak simetris. 

Cara yang serupa dapat diterapkan untuk menentukan tulangan kolektor, 

hanya saja sewaktu draw section cut harus di dekat elemen vertikal. Di bawah ini 

adalah hasil section cut untuk tulangan kolektor.  

 

 

Gambar 4.55 Section Cut Forces untuk Tulangan Kolektor 
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Gaya tarik yang terjadi adalah 65,85 kN, maka As = Tu* Ω0/(∅*fy) = 

65.850*2,5 N/(0,9*420) = 762,16 mm2. Dari hasil As perlu tersebut akan 

dipasang 10 buah tulangan D10 mm. Untuk mengetahui batas izin tekan yang 

terjadi, bisa dilihat di Pasal 18.12.7.5 SNI 2847:2019. Diketahui bahwa batas izin 

tekan adalah 0,2*fc*Apelat = 0,2*30*(21,6,-16,18)*1000*125 = 4.065 kN. Jika 

dibandingkan gaya tekan yang terjadi yaitu sebesar 65,85 kN*2,5 = 164,63 kN 

dengan kata lain gaya tekan tidak perlu memenuhi syarat tulangan 

transversal/pengekang untuk komponen tekan. 

13. Faktor Redundansi 

Faktor redundansi dalam SNI 1726:2019 merupakan faktor pengali yang 

digunakan untuk memperhitungkan tingkat redundansi atau keberulangan sistem 

struktural dalam mendistribusikan gaya seismik, sehingga mencegah kegagalan 

total jika salah satu elemen struktural mengalami kerusakan. Faktor ini, 

dilambangkan dengan ρ, bertujuan untuk meningkatkan keamanan struktur pada 

kategori desain seismik yang lebih tinggi, seperti D, E, atau F, dengan memastikan 

bahwa desain memperhitungkan potensi kehilangan elemen penahan gaya tanpa 

menyebabkan kegagalan progresif. Secara umum, faktor redundansi 

memengaruhi perhitungan gaya internal akibat beban gempa, di mana nilai yang 

lebih tinggi diterapkan pada struktur dengan redundansi rendah untuk 

mengompensasi risiko yang lebih besar selama kejadian gempa 

Penentuan nilai faktor redundansi bergantung pada konfigurasi struktur 

dan apakah memenuhi persyaratan tertentu untuk dianggap memiliki redundansi 

yang memadai. Menurut ketentuan, nilai ρ diambil sebagai 1,0 jika struktur 

memenuhi syarat seperti memiliki setidaknya dua bay portal penahan gaya pada 

perimeter untuk setiap arah gempa dan tidak memiliki ketidakberaturan horizontal 

yang signifikan, terutama pada tingkat yang menahan lebih dari 35% geser dasar. 

Namun, jika syarat tersebut tidak terpenuhi, nilai ρ ditingkatkan menjadi 1,3, yang 

secara efektif meningkatkan gaya geser seismik horizontal hingga 30% untuk 

memastikan margin keamanan yang lebih besar. Evaluasi ini dilakukan melalui 

analisis struktural, termasuk pelepasan sementara elemen kritis untuk 

memverifikasi kapasitas sisa. 

Berikut ini adalah kondisi di mana nilai ρ harus diambil sebesar 1 dan 1,3: 

a. Jika ρ diambil sebesar 1 

• Desain struktur untuk kategori desain seismik B atau C; 

• Perhitungan simpangan antar tingkat dan pengaruh P-delta; 

• Desain komponen nonstruktural; 

• Desain struktur nongedung yang tidak mirip dengan bangunan gedung; 
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• Desain elemen kolektor, sambungan lewatan, dan sambungan, yang 

memperhitungkan kombinasi pengaruh beban seismik termasuk faktor 

kuat lebih berdasarkan Pasal 7.4.3; 

• Beban diafragma yang ditentukan menggunakan Persamaan (51), 

termasuk batasan yang disyaratkan oleh Persamaan (52) dan Persamaan 

(53); 

• Desain struktur dengan sistem peredam sesuai Pasal 13 dan 

• Desain dinding struktural terhadap gaya keluar bidang, termasuk sistem 

angkurnya. 

b. Jika ρ diambil sebesar 1,3 

• Masing-masing tingkat yang menahan lebih dari 35 % geser dasar dalam 

arah yang ditinjau harus sesuai dengan Tabel 15 dan 

• Struktur dengan denah beraturan di semua tingkat dengan sistem pemikul 

gaya seismik terdiri dari paling sedikit dua bentang perimeter pemikul 

gaya seismik yang merangka pada masing-masing sisi struktur dalam 

masing-masing arah ortogonal di setiap tingkat yang menahan lebih dari 

35 % geser dasar. Jumlah bentang untuk dinding geser harus dihitung 

sebagai panjang dinding geser dibagi dengan tinggi tingkat atau dua kali 

panjang dinding geser dibagi dengan tinggi tingkat, hsx, untuk konstruksi 

rangka ringan.. 

14. Kombinasi Pembebanan 

Kombinasi pembebanan dalam SNI 1727:2020 menetapkan persyaratan 

minimum untuk menggabungkan berbagai jenis beban seperti beban mati (D), 

beban hidup (L), beban angin (W), dan beban gempa (E) dalam perencanaan 

bangunan gedung dan struktur lain. Standar ini membedakan antara metode desain 

kekuatan (load and resistance factor design) dan metode tegangan izin (allowable 

stress design), dengan tujuan memastikan struktur memiliki kekuatan dan 

stabilitas yang memadai terhadap beban ekstrem. Untuk metode desain kekuatan, 

kombinasi dasar mencakup 1,4D untuk beban mati saja, dan 1,2D + 1,6L + 0,5 

(Lr atau S atau R) untuk kombinasi dengan beban hidup dan beban atap. 

Pendekatan ini memperhitungkan faktor ketidakpastian dalam beban untuk 

mencapai keandalan target. 

Kombinasi pembebanan juga memperhitungkan persyaratan kemampuan 

layan, seperti lendutan dan getaran, dengan kombinasi nonterfaktor seperti D + L 

untuk evaluasi deformasi. Standar ini mengadopsi prinsip dari ASCE 7-16 dengan 

modifikasi untuk kondisi Indonesia, menghilangkan beban salju dan es, serta 

merujuk beban gempa ke SNI 1726:2019. Tujuannya adalah mencapai keandalan 

struktural yang tinggi, dengan penekanan pada kategori risiko bangunan untuk 

penentuan faktor beban tambahan. 
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Kombinasi pembebanan dalam SNI 1726:2019 dirancang untuk 

memastikan struktur bangunan gedung dan nongedung mampu menahan efek 

beban gempa secara aman, dengan mengintegrasikan beban seismik (E) ke dalam 

kombinasi beban keseluruhan. Beban seismik E dibagi menjadi efek horizontal 

(Eh) dan vertikal (Ev), di mana Eh mencakup gaya lateral dari guncangan gempa, 

sementara Ev mewakili komponen vertikal yang dapat memperbesar atau 

mengurangi beban gravitasi. Faktor redundansi (ρ) diterapkan pada efek beban 

gempa horizontal untuk memperhitungkan tingkat redundansi sistem struktural, 

dengan nilai ρ = 1,0 untuk struktur dengan redundansi tinggi dan ρ = 1,3 untuk 

redundansi rendah. Pendekatan ini bertujuan untuk meningkatkan keandalan 

struktur terhadap kegagalan progresif selama kejadian gempa. 

Dalam metode desain kekuatan (strength design), kombinasi pembebanan 

yang mencakup beban gempa melibatkan persamaan seperti (1,2 + 0,2 S_DS) D 

+ ρ Q_E + L, di mana D adalah beban mati, S_DS adalah akselerasi desain spektral 

jangka pendek, Q_E adalah efek beban gempa, dan L adalah beban hidup. 

Kombinasi lain termasuk (0,9 - 0,2 S_DS) D + ρ Q_E untuk kasus di mana beban 

gempa mengurangi efek gravitasi. Efek vertikal Ev dihitung sebagai 0,2 S_DS D, 

yang ditambahkan atau dikurangkan tergantung arahnya, sementara Eh diambil 

sebagai ρ Q_E. Ketentuan ini memastikan bahwa desain memperhitungkan 

interaksi antara beban gravitasi dan seismik, dengan penekanan pada kategori 

desain seismik yang lebih tinggi seperti D, E, atau F. 

Untuk metode tegangan izin (allowable stress design), kombinasi 

pembebanan disesuaikan dengan faktor lebih rendah, seperti (1,0 + 0,14 S_DS) D 

+ 0,7 ρ Q_E + L, atau (0,6 - 0,14 S_DS)D + 0,7 ρ Q_E. Pendekatan ini 

memungkinkan penggunaan tegangan izin material tanpa melebihi batas elastis, 

dengan penyesuaian untuk beban sementara seperti angin atau banjir jika relevan. 

SNI 1726:2019 menekankan bahwa kombinasi ini harus digunakan bersama 

dengan SNI 1727:2020 untuk beban nonseismik, memastikan konsistensi dalam 

perencanaan keseluruhan struktur. Evaluasi kombinasi juga mencakup 

pertimbangan overstrength faktor (Ω0) untuk elemen kritis dalam sistem seismik. 

a. Metode Load Resistance Factor Design (LRFD) 

• 1.4D 

• 1.2D + 1.6L + 0.5 (Lr atau S atau R) 

• 1.2D + 1.6 (Lr atau S atau R) + (L atau 0.5W) 

• 1.2D + 1W + L + 0.5 (Lr atau S atau R) 

• 0.9D + 1W 

• 1.2D + Ev + Eh + L + 0.2S 

• 0.9D – Ev + Eh 
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b. Metode Allowable Stress Design (ASD) 

• D 

• D + L 

• D + (Lr atau S atau R) 

• D + 0.75L + 0.75 (Lr atau S atau R) 

• D + 0.6W 

• D + 0.75L + 0.75 (0.6W) + 0.75 (Lr atau S atau R) 

• 0.6 D + 0.6W 

• 1D + 0.7Ev + 0.7Eh 

• 1D + 0.525Ev + 0.525Eh + 0.75L + 0.75S 

• 0.6D – 0.7Ev + 0.7Eh 
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BAB 5  

 

BENTUK ALAMI GETARAN 
 

 

A. Bentuk Getar Alami (Mode Shape) 

Mode shape dalam SNI 1726:2019 merujuk pada pengaruh bentuk getar alami 

(mode shape) struktur terhadap respons dinamis selama gempa, yang menjadi dasar 

dalam analisis spektrum respons modal untuk mengevaluasi distribusi gaya lateral 

dan deformasi. Mode shape menggambarkan pola deformasi struktur pada setiap 

ragam getar, di mana mode pertama biasanya mendominasi translasi pada struktur 

rendah, sementara mode higher (seperti mode kedua atau ketiga) memberikan 

kontribusi signifikan pada struktur tinggi atau tidak beraturan, menyebabkan 

amplifikasi geser dan momen di tingkat atas. Efek ini memastikan bahwa analisis 

memperhitungkan interaksi antar mode, menghindari asumsi sederhana dari metode 

statik yang mungkin mengabaikan efek mode higher, sehingga meningkatkan akurasi 

prediksi kegagalan lokal. 

Penentuan mode shape melibatkan perhitungan faktor partisipasi massa 

efektif untuk setiap mode, di mana jumlah ragam getar harus mencakup minimal 90% 

massa struktur untuk arah horizontal dan vertikal. Jika mode-mode memiliki periode 

yang berdekatan, kombinasi respons dilakukan menggunakan metode Complete 

Quadratic Combination (CQC) untuk memperhitungkan korelasi antar mode, 

sementara metode Square Root of the Sum of Squares (SRSS) digunakan untuk mode 

yang terpisah. Efek ini juga memengaruhi penskalaan gaya geser dasar dinamik agar 

tidak kurang dari nilai statik ekuivalen, memastikan margin keamanan terhadap 

respons nonlinier akibat gempa. 

Implikasi mode shape dalam desain adalah peningkatan ketahanan struktur 

terhadap deformasi berlebih, terutama pada kategori desain seismik tinggi, dengan 

persyaratan pemodelan 3D untuk menangkap efek torsi dari mode shape yang tidak 

simetris. Ketentuan ini bertujuan untuk mencegah kegagalan progresif dengan 

mempertimbangkan kontribusi penuh dari semua mode relevan. 

Untuk melihat animasi defleksi arah X dan Y pada ETABS, adalah dengan 

mengembalikan tampilan menjadi 3 dimensi lalu klik F6 → Mode → Modal Number 

Mode 1 → OK. 
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Gambar 5.1 Mode Shape 1 (arah X atau UX) 

 

 

Gambar 5.2 Mode Shape 2 (arah Y atau UY) 
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Gambar 5.3 Mode Shape 3 (arah Z atau UZ) 

 

B. Partisipasi Massa 

Dikatakan di SNI 1726:2019 Pasal 7.9.1 partisipasi massa dalam merujuk 

pada proporsi massa struktur yang berkontribusi terhadap respons dinamis pada setiap 

ragam getar alami selama analisis spektrum respons modal. Konsep ini penting untuk 

memastikan bahwa analisis dinamis secara akurat merepresentasikan perilaku 

struktur terhadap beban gempa, dengan mempertimbangkan distribusi massa secara 

tiga dimensi. Partisipasi massa dihitung untuk setiap arah utama (X, Y, dan vertikal), 

dan jumlah ragam getar yang dianalisis harus mencakup minimal 90% massa 

partisipasi efektif untuk arah horizontal serta 100% untuk arah vertikal, guna 

menghindari underestimation gaya lateral atau vertikal yang signifikan. Pendekatan 

ini memungkinkan evaluasi yang lebih realistis, terutama pada struktur tinggi atau 

tidak beraturan yang memiliki mode getar kompleks. 

Pada umumnya, nilai maksimum dari modal pada software ETABS adalah 12. 

Akan tetapi, itu bisa disesuaikan jika partisipasi massa kurang dari 90% pada modal 

ke 12. Untuk mengetahui berapa persen partisipasi massa dari gedung kantor ini, 

caranya adalah klik CTRL+T → Analysis Results → Structure Output → Modal 

Information → Table: Modal Participating Mass Ratios → OK. 
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Gambar 5.4 Choose Table for Display 
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Dapat dilihat di bagian SumUX dan SumUY, modal participating mass ratios 

pada modal ke 12 sudah melebihi 90% dengan modal ke 1 (UX) dan ke 2 (UY) adalah 

defleksi arah X dan Y, bukan Z. Dengan kata lain, partisipasi massa pada struktur 

gedung yang kita rancang sudah memenuhi syarat. 
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PERHITUNGAN GAYA GEMPA 
 

 

A. Pusat Massa dan Pusat Kekakuan 

Pusat massa dalam SNI 1726:2019 merujuk pada titik di mana total massa 

struktur pada suatu tingkat atau diafragma dapat dianggap terkonsentrasi, sehingga 

menjadi acuan untuk menentukan gaya inersia yang dihasilkan selama gempa. 

Konsep ini penting dalam analisis seismik karena eksentrisitas antara pusat massa dan 

pusat kekakuan dapat memicu momen torsi tambahan, yang meningkatkan risiko 

deformasi tidak seragam dan kegagalan elemen struktural. Pusat massa dihitung 

berdasarkan distribusi berat efektif lantai, termasuk beban mati, sebagian beban 

hidup, dan massa elemen nonstruktural, dengan mempertimbangkan variasi massa 

antar tingkat untuk memastikan akurasi respons dinamis struktur. 

Penentuan pusat massa melibatkan perhitungan koordinat massa untuk setiap 

tingkat berdasarkan posisi dan magnitudo berat, yang biasanya dilakukan melalui 

pemodelan tiga dimensi untuk struktur kompleks. Eksentrisitas tak terduga, minimal 

5% dari dimensi rencana, ditambahkan untuk memperhitungkan ketidakpastian dalam 

distribusi massa atau kekakuan, terutama pada bangunan dengan ketidakberaturan 

horizontal seperti bentuk L atau T. Ketentuan ini memastikan bahwa analisis 

mempertimbangkan efek torsio bawaan dan tak terduga, dengan penskalaan gaya 

geser dasar yang disesuaikan jika analisis dinamis digunakan, guna menghindari 

underestimation beban pada sambungan atau elemen penahan gaya lateral. 

Pusat kekakuan dalam SNI 1726:2019 merujuk pada titik konsentrasi 

kekakuan lateral struktur pada suatu tingkat atau diafragma, di mana penerapan gaya 

lateral tidak menghasilkan rotasi atau torsi netral. Konsep ini penting untuk 

menganalisis eksentrisitas antara pusat kekakuan dan pusat massa, yang dapat 

menyebabkan momen torsi tambahan selama gempa, sehingga meningkatkan risiko 

deformasi tidak merata pada elemen struktural. Pusat kekakuan dihitung berdasarkan 

distribusi kekakuan elemen vertikal seperti dinding geser, rangka, atau bracing, dan 

digunakan untuk mengevaluasi ketidakberaturan horizontal seperti tipe torsi, 

memastikan desain struktur memperhitungkan distribusi gaya seismik yang akurat. 

Aplikasi pusat kekakuan meliputi perhitungan perpindahan maksimum pada 

sistem isolasi seismik, di mana eksentrisitas sesungguhnya dan tak terduga (minimal 

BAB 6 
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5% dimensi rencana) diintegrasikan untuk menentukan defleksi total. Pada struktur 

dengan diafragma kaku, pusat kekakuan memengaruhi distribusi gaya geser 

horizontal dan momen torsi bawaan, sementara pada struktur nonbangunan, kriteria 

jarak minimal 5% dari pusat massa digunakan untuk mengecualikan analisis torsi tak 

terduga. Perhitungan ini sering dilakukan melalui pemodelan komputer, dengan 

mempertimbangkan kekakuan in-plane diafragma dan elemen vertikal untuk 

menghindari underestimation beban pada sambungan kritis. 

Implikasi pusat kekakuan dalam desain seismik adalah peningkatan ketahanan 

struktur terhadap kegagalan lokal, terutama pada kategori desain seismik tinggi, 

dengan persyaratan analisis dinamis jika eksentrisitas signifikan. Ketentuan ini 

bertujuan untuk mencegah kerusakan progresif dengan memastikan keseimbangan 

kekakuan vertikal dan horizontal, sehingga struktur tetap stabil selama guncangan. 

Sebelum running model yang telah dibuat, ada baiknya untuk menceklis nilai 

pusat kekakuan (Center of Rigidity) pada software ETABS. Caranya adalah klik menu 

Analyze → Set Load Cases to Run → centang bagian Diaphragm Centers of Rigidity 

→ Run Now. 

 

 

Gambar 6.1 Set Load Cases to Run 

 

Untuk mengetahui nilai pusat massa dan pusat kekakuan pada software 

ETABS adalah dengan klik CTRL+T → Analysis Results → Structure Output → 

Other Output Items → Table: Center of Mass and Rigidity → OK. 
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Gambar 6.2 Choose Table for Display 

 

  



 

 

  

 161 Perhitungan Gaya Gempa 

 

 

  

T
a
b

el 6
.1

 

C
en

ter o
f M

a
ss a

n
d
 R

ig
id

ity 



162 Desain Gedung Kantor 26 Lantai Menggunakan Sistem Ganda 

 

L
al

u
 s

et
el

ah
 i

tu
, 
k
it

a 
m

en
y
al

in
 d

at
a 

p
ad

a 
ta

b
el

 E
T

A
B

S
 t

er
se

b
u
t 

k
e 

sh
ee

t 
E

x
ce

l 
y
an

g
 t

el
ah

 d
ib

u
at

 s
ep

er
ti

 d
i 

tu
n
ju

k
k
an

 p
ad

a 
ta

b
el

 

d
i 

b
aw

ah
. 

T
a

b
el

 6
.2

 

S
u
m

m
a
ry

 C
en

te
r 

o
f 

M
a
ss

 a
n
d
 R

ig
id

it
y  

 



 

 

  

 163 Perhitungan Gaya Gempa 

Berdasarkan tabel di atas, diketahui bahwa pusat massa dan pusat kekakuan 

jaraknya berhimpitan, sehingga meminimalkan efek torsi. 

B. Perhitungan Pembesaran Momen Torsi tak Terduga 

Torsi tak terduga sebagaimana diatur dalam SNI 1726:2019, merujuk pada 

momen puntir tambahan yang diperhitungkan dalam desain seismik untuk 

mengakomodasi ketidakpastian atau ketidaksempurnaan dalam distribusi massa dan 

kekakuan struktur bangunan. Torsi ini timbul akibat eksentrisitas tak sengaja 

(accidental eccentricity), yang diasumsikan terjadi meskipun struktur dirancang 

dengan pusat massa dan pusat kekakuan yang sejajar. Ketentuan ini penting untuk 

memastikan bahwa bangunan tetap aman terhadap efek puntiran yang tidak 

terantisipasi selama gempa, terutama pada bangunan dengan denah tidak beraturan 

atau kompleks dan harus memenuhi Tabel 13 SNI 1726:2019. 

Jika diafragma tidak fleksibel, desain harus menyertakan momen torsi bawaan 

(Mt) yang dihasilkan dari lokasi massa struktur ditambah momen torsi tak terduga 

(Mta) akibat perpindahan pusat massa dari lokasi aktualnya yang diasumsikan pada 

masing-masing arah dengan jarak sebesar 5% dimensi struktur tegak lurus terhadap 

arah gaya yang diterapkan. 

Dilihat dari Pasal 7.8.4.3 di sana dikatakan bahwa struktur yang didesain 

untuk kategori desain seismik C, D, E, atau F, di mana ketidakberaturan torsi tipe 1a 

atau 1b terjadi seperti didefinisikan dalam Tabel 13 harus mempunyai pengaruh yang 

diperhitungkan dengan mengalikan Mta di masing-masing tingkat dengan faktor 

pembesaran torsi (Ax) ditentukan dari persamaan di bawah. 

 

 

Dan jika kita lihat pada ketidakberaturan horizontal pada struktur gedung 

kantor yang didesain ini, disimpulkan bahwa gedung kantor ini TIDAK MEMILIKI 

KETIDAKBERATURAN TORSI 1a DAN 1b. Maka dari itu, perlu juga dilakukan 

perhitungan pembesaran momen torsi tak terduga pada arah X dan Y bangunan. 

Untuk melakukan perhitungan pembesaran momen torsi tak terduga, ada 

baiknya kita mengetahui terlebih dahulu berapa joint displacement tiap lantainya. 

Caranya adalah klik CTRL+T → Analysis Results → Joint Output → Displacement 

→ OK. 
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Gambar 6.3 Choose Table for Display 

 

Setelah itu pada bagian Output Case pilih RS-X Scaled dan RS-Y Scaled, lalu 

pada menu File pilih opsi Export Current Table to Excel. 
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Lakukan penyortiran antara nilai minimum dan maksimum pada joint 

displacement arah X dan Y setiap lantai seperti yang ditunjukkan tabel di bawah. 

 

Tabel 6.4  

Joint Displacement Arah X 
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Tabel 6.5 

Joint Displacement Arah Y 

 

 

Langkah selanjutnya adalah membuat sheet Excel untuk menghitung 

pembesaran momen torsi tak terduga berdasarkan Pasal 7.8.4.3 SNI 1726:2019. 
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PENULANGAN SISTEM GANDA 
 

 

A. Penulangan Lentur dan Geser Pada Balok 

Penulangan untuk Sistem Rangka Pemikul Momen Khusus (SRPMK) dalam 

SNI 2847:2019 dirancang untuk memastikan daktilitas tinggi dan kemampuan 

struktur beton bertulang dalam menyerap energi seismik tanpa kegagalan mendadak. 

Penulangan ini mencakup persyaratan khusus pada balok, kolom, dan sambungan 

untuk mencapai rotasi plastis yang memadai, dengan batasan rasio tulangan lentur 

maksimum sebesar 0,025 dan minimum 0,005 pada balok, serta penggunaan 

sengkang pengekang untuk mencegah buckling tulangan longitudinal. Ketentuan ini 

bertujuan untuk membentuk mekanisme plastis yang diinginkan, di mana balok 

mengalami hinging sebelum kolom, sesuai prinsip "strong column-weak beam", 

sehingga meningkatkan ketahanan keseluruhan struktur terhadap gempa. 

Untuk balok SRPMK, penulangan lentur harus memenuhi ketentuan bahwa 

tulangan tarik dan tekan pada penampang harus mampu menahan momen positif dan 

negatif minimal 1/4 dan 1/2 dari momen maksimum, dengan jarak sengkang dibatasi 

maksimal d/2 atau 150 mm di zona plastis. Pada kolom, tulangan transversal berupa 

sengkang atau spiral harus menyediakan pengekangan yang cukup untuk menahan 

gaya aksial dan lentur, dengan jarak maksimal 1/4 dimensi terkecil kolom atau 100 

mm, serta luas tulangan minimal 0,01 Ag. Sambungan balok-kolom memerlukan 

tulangan transversal yang kontinu untuk menahan geser dan memastikan anchorage 

tulangan balok melewati joint dengan panjang penyaluran yang memadai. 

Perhitungan balok induk dibantu dengan program analisa struktur. Hasil 

perhitungan dari analisa struktur perlu dilakukan verifikasi dengan perhitungan 

manual supaya mengetahui bahwa hasil output dari program analisa struktur valid. 

Penulangan SRPMK ini secara rinci diatur dalam SNI 2847:2019 pada Pasal 

18, dengan subpasal 18.6 untuk balok, 18.7 untuk kolom, dan 18.8 untuk sambungan 

balok-kolom. 

Sebagai sample, kita akan mengambil contoh balok dengan ukuran 400 mm x 

600 mm, dan 300 mm x 500 mm yang diberi tanda awan berwarna biru seperti 

ditunjukkan gambar di bawah. 
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Gambar 7.1 Sample Penulangan Balok 
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Berdasarkan dari hasil perhitungan tabel di atas, penulis melakukan 

perbandingan kembali menggunakan perhitungan dengan cara yang lebih kompleks 

seperti ditunjukkan tabel di bawah ini. 

 

Tabel 7.2 

Properti Material dan Penampang  

 

 

Untuk mengetahui berapa nilai gaya dalam yang bekerja di dalam balok yang 

kita tinjau, caranya adalah dengan klik CTRL+T → Analysis Results → Element 

Output → Frame Output → Table: Element Forces – Beams → pada bagian Select 

Combos pilih semua kombinasi beban LRFD, Service dan untuk Vg. 
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Gambar 7.2 Choose Tables for Display 

 

Setelah itu, export tabel tersebut ke Microsoft Excel untuk memudahkan 

dalam menghitung gaya dalam yang terjadi. Lakukan penyortiran pada semua kolom 

dengan cara memunculkan tanda panah sortir. 

 

 

Gambar 7.3 Sketsa Balok B46-2 

 

Bisa kita lihat pada gambar di atas bahwa batas pada tumpuannya adalah 1800 

mm atau 1,8 meter. Maka dari itu, lakukan sortir pada kolom Station, yang disortir 

adalah hanya batas maksimum tumpuan, caranya adalah klik panah yang ada di 

Station → Number Filter → Between → isi pada bagian atas is less than or equal to 
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ketik angka 1.8 lalu or lalu pada bagian bawahnya is less than or equal to ketik angka 

6.2 → OK. 

Untuk mengetahui apa saja yang dimasukkan ke dalam sheet Excel yang akan 

dibandingkan, klik panah pada M3 → Smallest to Largest. Cara yang mirip bisa 

diterapkan pada bagian lapangan balok, hanya berbeda di bagian sortir station-nya 

saja. Caranya adalah klik panah yang ada di Station → Number Filter → Between → 

isi pada bagian atas is less than or equal to ketik angka 1.8 lalu and lalu pada bagian 

bawahnya is less than or equal to ketik angka 6.2 → OK. 
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Berdasarkan Tabel 7.6 dan 7.7 dapat disimpulkan bahwa jumlah tulangan 

lemur di bagian tumpuan atas dan bawah pada balok B46 dengan jumlah 14 buah pada 

bagian atas dan 7 buah pada bagian bawah, lalu hasilnya adalah OK. 

 

 

Gambar 7.4 Sketsa Penulangan Balok B46-2 Daerah Tumpuan dan Lapangan 

 

B. Penulangan Lentur dan Geser Pada Kolom 

Penulangan lentur pada kolom dalam SNI 2847:2019 mengacu pada 

penggunaan tulangan longitudinal untuk menahan kombinasi gaya aksial dan momen 

lentur, yang sering terjadi pada kolom sebagai elemen vertikal utama. Tulangan ini 

dirancang berdasarkan konsep penampang tekan dengan lentur, di mana luas tulangan 

minimum diatur untuk memastikan daktilitas dan pengendalian retak, sementara luas 

maksimum dibatasi untuk menghindari keruntuhan tekan yang rapuh. Rasio tulangan 

longitudinal minimum adalah 0,01 dari luas penampang bruto (Ag), sedangkan 

maksimum 0,06 Ag untuk kolom nonseismik, dengan penyesuaian untuk kolom 

komposit atau prategang. Perhitungan ini memperhitungkan faktor reduksi kekuatan 

(φ) sebesar 0,65 untuk kolom tekan murni dan hingga 0,9 untuk kolom dengan lentur 

dominan, memastikan kapasitas nominal melebihi beban terfaktor. 

Penulangan geser pada kolom melibatkan tulangan transversal seperti 

sengkang atau spiral untuk menahan gaya geser lateral, yang dapat timbul dari beban 

angin atau gempa. Kekuatan geser nominal (Vn) dihitung sebagai penjumlahan 

kekuatan beton (Vc) dan kekuatan tulangan (Vs), dengan Vc diambil sebagai 0,17√f'c 

b d untuk kolom tanpa beban aksial signifikan. Tulangan transversal minimum 

diwajibkan jika gaya geser terfaktor (Vu) melebihi 0,5 φ Vc, dengan luas sengkang 

(Av) minimal 0,75√f'c b s / fy atau 0,4 b s / fy. Jarak sengkang dibatasi maksimum 16 
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kali diameter tulangan longitudinal atau 48 kali diameter sengkang untuk memastikan 

pengekangan yang cukup terhadap buckling. 

Penulangan geser pada kolom SRPMK memerlukan perhitungan Vs dengan 

asumsi Vc = 0 di zona plastis jika gaya geser tinggi, menggunakan tulangan 

transversal yang lebih rapat untuk menahan geser seismik. Jarak sengkang di zona 

tumpuan dibatasi maksimum 100 mm atau 1/4 dimensi kolom terkecil, sementara di 

lapangan hingga 150 mm, dengan luas Av minimal berdasarkan rumus pengekang 

untuk mencegah kegagalan geser diagonal. Ketentuan ini memastikan kolom tetap 

stabil selama deformasi besar, dengan integrasi faktor overstrength dari SNI 

1726:2019. 

Secara keseluruhan, penulangan lentur dan geser pada kolom dalam standar 

ini menekankan keseimbangan antara kekuatan, daktilitas, dan ekonomi, dengan 

evaluasi melalui diagram interaksi untuk lentur dan rumus empiris untuk geser. 

Persyaratan ini diterapkan untuk berbagai kategori risiko bangunan, memastikan 

keamanan struktural terhadap beban gravitasi dan lateral. 

Perhitungan balok induk dibantu dengan program analisa struktur. Hasil 

perhitungan dari analisa struktur perlu dilakukan verifikasi dengan perhitungan 

manual supaya mengetahui bahwa hasil output dari program analisa struktur valid. 

Di bawah ini adalah sampel kolom yang akan dianalisis (ditandai dengan awan 

berwarna hijau). 
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Gambar 7.5 Sample Penulangan Kolom 

 

 

Gambar 7.6 Sketsa Kolom 800 x 800 

 

Untuk mengetahui berapa nilai gaya dalam yang bekerja di dalam kolom yang 

kita tinjau, caranya adalah dengan klik CTRL+T → Analysis Results → Element 

Output → Frame Output → Table: Element Forces – Column → pada bagian Select 

Combos pilih semua kombinasi beban LRFD, lalu Export to Excel. 
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Gambar 7.7 Choose Tables for Display 

 

Tabel 7.9 

Hasil Expor Element Forces - Column 

 

 

Munculkan tanda panah penyortiran pada setiap kolom, lalu pindahkan kolom 

M2 dan M3 tepat setelah kolom P agar lebih mudah dalam menyalin gaya-gaya dalam 

tersebut. Setelah itu, pilih Output Case hanya gaya LRFD saja. 
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Tabel 7.10 

Element Forces – Column yang Akan Disortir 

 

 

Kemudian sortir menjadi nilai largest to smallest di kolom P untuk 

mendapatkan nilai Pmax, lalu salin sampai ke kolom M3. Lakukan cara yang sama 

untuk mendapatkan nilai Pmin, M2max, M2min, M3max, dan M3min. 

 

Tabel 7.11 

Element Forces – Column yang Telah Disortir Berupa Aksial - Lentur 

 

 

Setelah itu, beralih ke software SPColumn untuk memasukkan nilai-nilai 

Pmax, Pmin, M2max, M2min, M3max, dan M3min tadi dan sesuaikan seperti gambar 

di bawah ini. 
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Gambar 7.8 Software SPColumn 

 

 

Gambar 7.9 Penyesuaian Mutu Bahan 
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Gambar 7.10 Penyesuaian Section 

 

Input semua nilai aksial – lentur yang kita peroleh tadi di bagian Load → 

Factored Loads. Kemudian klik tombol F5 untuk Execute. 

 

Tabel 7.12 

Input Factored Loads 
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Gambar 7.11 Diagram Interaksi Kolom Dengan Gaya yang Paling Besar 

 

Bisa dilihat pada gambar di atas bahwa gaya yang paling besar titiknya masih 

berada di dalam diagram interaksi yang berwarna biru. Maka dari itu, dapat dikatakan 

bahwa desain kolom ini aman. 

Langkah selanjutnya adalah dengan mengekspor tabel yang telah dianalisis ke 

Excel. Lalu hitung nilai Mnx dan Mny dengan cara membagi nilai ɸMnx dan ɸMnx 

dengan ɸ. Ambil nilai absolut terkecilnya, lalu masukkan ke sheet Excel untuk 

menganalisis kolom SRMPK dan mengecek syarat Strong Column Weak Beam 

(SCWB). 
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Gambar 7.12 Sketsa Penulangan Kolom 800 x 800 

 

C. Penulangan Geser Joint Balok - Kolom 

Hubungan balok-kolom dalam SNI 2847:2019 Pasal 18.8 merujuk pada 

sambungan struktural antara elemen balok dan kolom pada struktur beton bertulang, 

yang berfungsi sebagai titik transfer gaya aksial, lentur, dan geser. Sambungan ini 

menjadi elemen kritis terutama dalam desain tahan gempa, karena kegagalan pada 

hubungan dapat menyebabkan keruntuhan progresif struktur. Ketentuan ini 

menekankan prinsip desain yang memastikan daktilitas tinggi, sehingga sambungan 

mampu menyerap energi seismik tanpa kegagalan mendadak. Pada struktur dengan 

Sistem Rangka Pemikul Momen Khusus (SRPMK), hubungan balok-kolom 

dirancang untuk membentuk sendi plastis pada balok, bukan pada kolom, sesuai 

konsep "strong column-weak beam". Hal ini memerlukan evaluasi kekuatan nominal 

sambungan terhadap gaya geser yang dihitung dari kombinasi beban gravitasi dan 

lateral. 

Implikasi hubungan balok-kolom dalam desain keseluruhan adalah 

peningkatan ketahanan struktur terhadap guncangan, dengan penekanan pada kategori 

risiko tinggi. Ketentuan ini memastikan bahwa sambungan tidak menjadi titik lemah, 

sehingga struktur tetap stabil dan aman untuk okupansi pasca-gempa. Perubahan dari 

SNI 2847:2013 ke 2019 mencakup penyesuaian rumus dan detailing untuk lebih 

selaras dengan ACI 318-19, meningkatkan efisiensi tanpa mengurangi keamanan. 

Gaya-gaya pada tulangan longitudinal balok di muka joint harus dihitung 

dengan mengasumsikan tegangan pada tulangan tarik lentur adalah 1,25fy. Tulangan 

longitudinal balok yang dihentikan di dalam suatu kolom harus diteruskan ke muka 
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terjauh dari inti kolom terkekang dan harus disalurkan dalam tarik sesuai Pasal 18.8.5 

dan dalam tekan sesuai Pasal 25.4.9 SNI 2847:2019. 

 

 

Gambar 7.13 Luas Joint Efektif 

 

Bila tulangan longitudinal balok diteruskan melalui joint balok-kolom, 

dimensi kolom yang paralel dengan tulangan balok tersebut tidak boleh kurang dari 

20 kali diameter tulangan longitudinal terbesar balok untuk beton normal (normal 

weight). Untuk beton ringan (light weight), dimensinya tidak boleh kurang dari 26 

kali diameter tulangan. 

Untuk mengetahui nilai rasio joint shear capacity pada ETABS, caranya 

adalah klik Shift+Ctrl+F6 → Joint Shear Capacity Ratios. 

 

 

Gambar 7.14 Joint Shear Capacity Ratios 
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Tabel 7.15 

Kekuatan Geser Nominal Joint 

 

(Sumber: Tabel 18.8.4.1 SNI 2847:2019) 

 

Untuk menganalisis penulangan geser pada joint balok – kolom, terlebih 

dahulu mengambil sampel yang akan dijadikan acuan seperti di bawah ini. 

 

 

Gambar 7.15 Sample Penulangan Geser Joint Balok - Kolom 
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Gambar 7.16 Tiga Dimensi Sample Penulangan Geser Joint Balok – Kolom 

 

Jika lebih diperhatikan lagi, posisi balok dan kolom yang akan dianalisis 

berada pas AS. Jadi AS balok tepat di tengah AS kolom. 

 

Gambar 7.17 Letak AS Kolom dan Balok 
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Gambar 7.18 Cek Joint Shear Capacity Ratios AS G2-A 
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Balok induk yang digunakan berukuran 400 x 600 dan kolom berukuran 800 

x 800, sehingga balok yang kita desain termasuk balok yang merangka, bukan 

mengekang (lihat Pasal 18.8.4.2) yang mengatakan bahwa lebar balok ≥ 
3

4
 lebar 

kolom. Dihitung dari rumus tersebut, didapat bahwa lebar balok kurang dari 
3

4
 lebar 

kolom, maka nilai c = 1. 

 

Tabel 7.16 

Input Properti Material 
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Tabel 7.17 

Input Dimensi Joint dan Gaya Tulangan Balok 
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Tabel 7.18 

Input Gaya Geser 
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Tabel 7.19 

Input Gaya Geser Total Joint 

 

D. Pengecekan Rasio SCWB 

Rasio Strong Column Weak Beam (SCWB) dalam SNI 2847:2019 merupakan 

prinsip desain seismik yang bertujuan untuk memastikan bahwa kolom memiliki 

kekuatan lentur yang lebih besar daripada balok yang terhubung padanya, sehingga 

sendi plastis terbentuk terlebih dahulu pada balok selama kejadian gempa. Prinsip ini 

mencegah kegagalan mendadak pada kolom, yang dapat menyebabkan keruntuhan 

progresif struktur, dan mempromosikan perilaku duktil struktur secara keseluruhan. 

Rasio SCWB dihitung sebagai perbandingan antara jumlah kekuatan lentur nominal 

kolom (ΣMnc) di atas dan di bawah sambungan dengan jumlah kekuatan lentur 

nominal balok (ΣMnb) yang menumpu pada sambungan tersebut. Ketentuan ini 

diterapkan pada Sistem Rangka Pemikul Momen Khusus (SRPMK) untuk 

meningkatkan ketahanan bangunan terhadap beban gempa, dengan 

mempertimbangkan faktor overstrength dari SNI 1726:2019. 

Implikasi dari penerapan rasio SCWB adalah peningkatan biaya material 

karena kolom yang lebih kuat, tetapi hal ini diimbangi dengan peningkatan keamanan 

dan umur pakai struktur. Standar ini menekankan bahwa pengecekan SCWB harus 
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dilakukan setelah penentuan dimensi awal, dengan penyesuaian jika diperlukan untuk 

memenuhi batas minimum. Prinsip ini selaras dengan standar internasional seperti 

ACI 318, yang menjadi dasar SNI 2847:2019, dan bertujuan untuk mengurangi risiko 

kerusakan berat pada bangunan di wilayah rawan gempa seperti Indonesia. 

Secara keseluruhan, rasio SCWB merupakan elemen kunci dalam filosofi 

desain tahan gempa, yang mendorong pembentukan hierarki kekuatan struktural 

untuk mencapai performa Immediate Occupancy atau Life Safety. Ketentuan ini juga 

memengaruhi pemilihan material beton dan baja tulangan, dengan penekanan pada 

kualitas tinggi untuk mencapai daktilitas yang diinginkan. Dengan demikian, rasio 

SCWB tidak hanya sebagai persyaratan teknis, tetapi juga sebagai strategi mitigasi 

risiko seismik yang holistik. 

Ketentuan mengenai rasio SCWB ini secara rinci diatur dalam SNI 2847:2019 

pada Pasal 18.7.3.2, yang menyatakan bahwa ΣMnc ≥ 1,2 ΣMnb untuk memenuhi 

prinsip Strong Column Weak Beam. 

Untuk melakukan pengecekan SCWB di ETABS, terlebih dahulu kita harus 

mengetahui konsep PMM Ratios. Column PMM Interaction Ratios di ETABS 

merupakan metrik yang digunakan untuk mengevaluasi kapasitas kolom beton 

bertulang terhadap kombinasi beban aksial (P) dan momen lentur biaxial (M2 untuk 

arah major dan M3 untuk arah minor). Rasio ini merepresentasikan perbandingan 

antara demand (beban terfaktor yang diterapkan) dengan capacity (kapasitas nominal 

kolom berdasarkan diagram interaksi PMM), yang dihitung berdasarkan permukaan 

interaksi tiga dimensi (interaction surface) untuk memastikan kolom tidak 

overstressed. Jika rasio kurang dari atau sama dengan 1, kolom dianggap aman; jika 

lebih dari 1, kolom dianggap overstressed dan memerlukan revisi desain, seperti 

penambahan tulangan atau peningkatan dimensi. 

Fungsi utama dari PMM Interaction Ratios adalah sebagai alat verifikasi 

desain dalam modul Concrete Frame Design ETABS, yang sesuai dengan kode 

seperti ACI 318. Rasio ini dihasilkan setelah analisis struktural dan desain, di mana 

ETABS menghitung titik beban (P, M2, M3) relatif terhadap permukaan interaksi 

yang dibangun dari distribusi regangan dan tegangan material (misalnya, regangan 

maksimum beton 0.003 dan tegangan baja hingga fy).  

Cara mengecek rasio PMM di ETABS adalah dengan klik Shift+Ctrl+F6 → 

Column P-M-M Interaction Ratios Ratio. 
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Gambar 7.19 Column P-M-M Interaction Ratios 

 

 

Gambar 7.20 Cek Column P-M-M Interaction Ratios AS G2-A 
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Gambar 7.21 Beam/Column Capacity Ratios 

 

 

Gambar 7.22 Cek Beam/Column Capacity Ratios AS G2-A 
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Dapat dilihat dari kedua pengecekan rasio di atas, nilai rasionya kurang dari 

1, yang artinya desain kita cukup aman. 

E. Perhitungan Kemampuan SRPMK Dalam Menanggung 
Minimal 25% Gaya Gempa Nominal 

Portal SRPMK, atau Sistem Rangka Pemikul Momen Khusus, dalam SNI 

1726:2019 merupakan komponen struktural yang dirancang untuk memberikan 

daktilitas tinggi dalam menahan beban gempa, terutama dalam sistem ganda yang 

menggabungkan rangka momen dengan dinding geser atau sistem lain. Ketentuan ini 

memastikan bahwa rangka mampu berperan sebagai cadangan jika dinding geser 

mengalami kerusakan, dengan mensyaratkan rangka menanggung minimal 25% gaya 

gempa nominal untuk mencegah kegagalan total struktur. Persyaratan ini diterapkan 

pada kategori desain seismik D, E, atau F, di mana respons struktur terhadap 

guncangan harus dianalisis secara dinamis untuk memverifikasi distribusi gaya 

lateral. Hal ini bertujuan untuk meningkatkan redundansi sistem, sehingga portal 

SRPMK tidak hanya mendukung beban gravitasi tetapi juga berkontribusi signifikan 

terhadap ketahanan seismik keseluruhan. 

Dalam sistem ganda, portal SRPMK harus didesain independen untuk 

menahan 25% gaya geser dasar (base shear) yang dihitung dari analisis statik 

ekuivalen atau dinamis, sesuai dengan parameter seismik situs seperti S_DS dan S_1. 

Persentase ini dianggap sebagai ambang minimum untuk memastikan bahwa rangka 

tetap berfungsi meskipun dinding geser mencapai kapasitas maksimalnya, 

menghindari konsentrasi deformasi pada satu sistem saja. Analisis harus mencakup 

efek torsi dan ketidakberaturan, dengan faktor modifikasi respons (R) untuk SRPMK 

biasanya 8, yang mengindikasikan tingkat daktilitas tinggi. Ketentuan ini juga 

memerlukan verifikasi melalui kombinasi beban seismik, di mana gaya nominal 

dikalikan dengan faktor overstrength jika diperlukan untuk elemen kritis. 

Penerapan 25% gaya gempa nominal pada portal SRPMK memengaruhi 

pemilihan material dan dimensi elemen, seperti kolom dan balok, yang harus 

memenuhi persyaratan detailing dari SNI 2847:2019 untuk mencapai daktilitas yang 

diinginkan. Dalam praktik, perhitungan ini dilakukan setelah menentukan gaya geser 

dasar V dari rumus Cs W, di mana 25% V menjadi beban minimum yang dialokasikan 

ke rangka. Hal ini mencegah over-reliance pada dinding geser, yang mungkin rentan 

terhadap kegagalan geser atau lentur selama gempa kuat. Ketentuan ini juga 

diintegrasikan dengan analisis efek P-Delta untuk memastikan stabilitas vertikal tetap 

terjaga di bawah beban tambahan tersebut. 

Untuk sistem ganda, rangka pemikul momen harus mampu memikul paling 

sedikit 25 % gaya seismik desain. Tahanan gaya seismik total harus disediakan oleh 
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kombinasi rangka pemikul momen dan dinding geser atau rangka bresing, dengan 

distribusi yang proporsional terhadap kekakuannya. 

Untuk melihat berapa nilai yang ditanggung oleh kombinasi dari SRPMK dan 

shear wall, caranya adalah blok semua joint yang ada di lantai dasar lalu klik 

CTRL+T → Joint Output → Reactions → Table: Joint Reactions. Pada bagian Select 

Load Cases isikan hanya gaya gempa yang sudah diskalakan saja, yaitu RS-X Scaled 

dan RS-Y Scaled. Kemudian klik OK. Seperti biasa ekspor tabel tersebut ke Microsoft 

Excel lalu sortir dimulai dari RS-X Scaled kemudian RS-X Scaled. Berikut adalah 

rekapan persentase gaya yang ditanggung oleh dual sistem dan SRPMK saja. 

 

Tabel 7.20 

Persentasi SRPMK Minimal 25% 

 

 

Dapat disimpulkan dari tabel di atas bahwa persentase gaya yang ditanggung 

oleh Sistem Rangka Pemikul Momen Khusus (SRPMK) minimal 25% sudah 

terpenuhi. 

F. Perhitungan Confinement Kolom 

Tulangan confinement pada kolom menurut Pasal 18.7.5 SNI 2847:2019 

dirancang untuk meningkatkan daktilitas dan ketahanan terhadap beban siklik, 

terutama pada struktur di daerah seismik tinggi. Tulangan ini berupa sengkang atau 

spiral transversal yang memberikan pengikat pada inti beton kolom, mencegah 

spalling selimut beton dan buckling tulangan longitudinal saat deformasi besar. 
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BAB 8 
 

 

PENULANGAN DINDING GESER 
 

 

A. Pengecekan Awal 

Pengecekan awal dinding geser dalam SNI 1726:2019 merupakan langkah 

penting untuk memastikan bahwa elemen ini dapat berfungsi sebagai sistem penahan 

gaya lateral utama selama kejadian gempa, sesuai dengan desain seismik yang 

ditentukan. Proses ini melibatkan evaluasi awal terhadap dimensi, kekakuan, dan 

kapasitas dinding geser untuk menahan gaya geser dasar yang dihitung dari analisis 

statik ekuivalen atau dinamis. Ketentuan ini bertujuan untuk memverifikasi bahwa 

dinding geser mampu mendistribusikan gaya lateral ke fondasi tanpa mengalami 

kegagalan sebelum elemen lain, terutama pada kategori desain seismik D, E, atau F, 

di mana beban gempa lebih signifikan. Pengecekan awal juga mempertimbangkan 

efek torsio dan ketidakberaturan untuk memastikan stabilitas keseluruhan struktur. 

Langkah awal pengecekan meliputi perhitungan gaya geser dasar (V) 

menggunakan rumus Cs W, di mana Cs adalah koefisien respons seismik dan W 

adalah berat efektif struktur. Dinding geser harus dirancang untuk menahan sebagian 

besar gaya ini, dengan verifikasi bahwa total kekuatan geser dinding tidak kurang dari 

nilai yang dihasilkan analisis. Ketentuan ini juga mensyaratkan evaluasi eksentrisitas 

antara pusat massa dan pusat kekakuan untuk menentukan kebutuhan analisis torsi 

tambahan, yang dapat memengaruhi distribusi gaya pada dinding geser. Pengecekan 

ini dilakukan sebelum detailing akhir untuk menghindari revisi besar pada tahap 

desain lanjutan. 

Implikasi dari pengecekan awal adalah identifikasi potensi kelemahan dini, 

seperti kekakuan yang tidak merata atau kapasitas geser yang kurang, yang dapat 

diatasi dengan penyesuaian desain. Ketentuan ini mendukung performa dinding geser 

dalam sistem ganda, di mana dinding harus bekerja bersama rangka pemikul momen 

khusus (SRPMK) yang menanggung minimal 25% gaya gempa nominal. Pengecekan 

ini juga memastikan bahwa dinding geser tetap elastis atau mengalami deformasi 

terkontrol untuk mencapai level performa Immediate Occupancy pasca-gempa. 
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B. Pengecekan Kebutuhan Boundary Element Dengan 
Simplify (C&T) 

Pengecekan kebutuhan boundary element dengan metode Simplify 

(Compression and Tension) dalam SNI 1726:2019 merupakan prosedur awal untuk 

menentukan apakah dinding geser memerlukan penguatan tambahan di ujung-

ujungnya untuk menahan tekanan dan tarik akibat beban gempa. Boundary element 

adalah daerah di tepi dinding geser yang diberi tulangan longitudinal dan transversal 

tambahan untuk meningkatkan daktilitas dan mencegah kegagalan akibat kompresi 

atau tegangan ekstrem. 
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C. Desain Tulangan Lentur 

Desain tulangan lentur pada shear wall menurut SNI 2847:2019 difokuskan 

pada kemampuan dinding untuk menahan momen lentur akibat beban lateral seperti 

gempa, di mana tulangan vertikal berfungsi sebagai tulangan utama untuk fleksural. 

Pada desain umum, shear wall diperlakukan sebagai elemen tekan dengan momen, 

sehingga perhitungan kekuatan lentur mengikuti persyaratan untuk anggota tekan 

pada Pasal 22.4, dengan rasio tulangan minimum vertikal sebesar 0,0012 untuk 

tulangan ulir deformasi (Pasal 11.6.1). Untuk memastikan daktilitas, tulangan lentur 

harus dirancang agar kekuatan nominal Mn tidak kurang dari kekuatan yang 

dibutuhkan Mu, dengan pertimbangan interaksi aksial-lentur menggunakan diagram 

interaksi. 

 

 

Gambar 8.1 Kebutuhan Luas Tulangan Lentur Shear Wall 

 

Untuk menampilkan nilai luas tulangan perlu seperti gambar di atas pada 

software ETABS, caranya klik Shift+F10 dan biarkan sampai analisis shear wall 

selesai dilakukan → Shift+Ctrl+F10 → Design Output → Pier Longitudinal 

Reinforcing. 
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D. Pengecekan D/C Ratios 

D/C ratio (Demand/Capacity ratio) untuk shear wall (dinding geser) adalah 

rasio antara permintaan beban (demand, seperti gaya geser Vu, momen Mu, aksial 

Pu) dari analisis struktur terhadap kapasitas desain (capacity, seperti φVn untuk geser, 

φMn untuk fleksural) elemen tersebut. Pengecekan ini memastikan shear wall aman 

terhadap beban gempa dan gravitasi, dengan D/C ≤ 1.0 sebagai batas keamanan (jika 

>1.0, elemen overstressed dan perlu revisi). Di ETABS (versi 18+ 

direkomendasikan), shear wall dimodelkan sebagai shell elements atau pier/spandrel, 

dan pengecekan dilakukan melalui modul Concrete Shell Design atau Shear Wall 

Design, yang mendukung kode mirip ACI 318-14 (basis SNI 2847:2019). 

 

 

Gambar 8.2 D/C Ratios Shear Wall 

 

Untuk mengetahui berapa nilai D/C ratio pada shear wall seperti yang 

ditunjukkan gambar di atas, caranya klik Shift+F10 dan biarkan sampai analisis shear 

wall selesai dilakukan → Shift+Ctrl+F10 → Design Output → Pier D/C Ratios → 

OK. Hasilnya terlihat seperti gambar di bawah. 
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Dapat dilihat dari gambar di atas bahwa semua angka pada D/C ratios shear 

wall nilainya di bawah 1, yang berarti desain shear wall pada struktur gedung kantor 

26 lantai ini aman untuk digunakan. 

E. Desain Tulangan Geser Pada Shear Wall 

Desain tulangan geser (shear reinforcement) pada shear wall (dinding geser) 

bertujuan untuk memastikan dinding dapat menahan gaya geser (Vu atau Ve untuk 

seismic) yang timbul dari beban gravitasi dan gempa, sambil memenuhi persyaratan 

ketahanan, daktilitas, dan detailing. Proses desain menggabungkan SNI 1726:2019 

untuk menentukan demand beban gempa (termasuk amplified shear force) dengan 

SNI 2847:2019 untuk menghitung kapasitas geser (Vn = Vc + Vs) dan kebutuhan 

tulangan. SNI 2847:2019 merupakan adaptasi dari ACI 318-14, sehingga rumus dan 

pasal mirip, dengan fokus pada Load Resistance Force Design (LRFD). Tulangan 

geser biasanya berupa tulangan horizontal (transversal) dalam dua lapis, dengan rasio 

minimal ρ_t = 0.0025, dan amplified untuk zona seismic tinggi agar kegagalan daktil. 

(fleksural sebelum geser). 

Untuk mengetahui berapa nilai luas tulangan geser yang diperlukan pada 

ETABS, caranya Shift+Ctrl+F10 → Design Output → Pier Shear Reinforcing → OK. 

F. Desain Tulangan Pengekang Pada Shear Wall 

Tulangan pengekang (confinement reinforcement) pada shear wall atau 

dinding geser merupakan elemen penting dalam desain struktur beton bertulang untuk 

meningkatkan daktilitas dan ketahanan terhadap beban gempa. Menurut SNI 

2847:2019, tulangan pengekang biasanya berupa hoop ties atau sengkang tertutup 

yang ditempatkan di elemen batas khusus (special boundary elements) pada ujung 

dinding geser, bertujuan untuk mencegah kegagalan tekan brittle dan memastikan 

deformasi plastis terkendali. Desain ini terintegrasi dengan SNI 1726:2019, yang 

mengatur demand beban gempa melalui analisis dinamik dan faktor amplifikasi, 

sehingga tulangan pengekang harus dirancang untuk menahan gaya geser amplified 

(Ve) agar kegagalan terjadi secara ductile. Proses desain melibatkan penentuan spasi 

tulangan, diameter, dan pengaitan untuk memenuhi persyaratan confinement mirip 

kolom seismic, dengan asumsi regangan tekan melebihi 0.003 memerlukan 

pengekang tambahan. 

Dalam SNI 2847:2019, desain tulangan pengekang secara rinci diatur untuk 

dinding geser khusus, di mana tulangan pengekang harus menggunakan hoop ties 

dengan sudut pengaitan 135° atau 180°, dan spasi (s) tidak boleh melebihi 1/3 dimensi 

terkecil elemen batas atau 100 mm di zona engsel plastik. Persyaratan ini memastikan 

volume tulangan pengekang (ρs) memenuhi rumus minimum untuk confinement, 
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seperti ρs ≥ 0.09 f'c / fy untuk spiral atau hoop, dengan penambahan tulangan 

transversal jika selimut beton >100 mm. Tulangan pengekang diperlukan jika 

tegangan tekan > 0.2*f'c atau regangan > 0.003, dan panjangnya minimal max(c, 

0.1*lw) di mana c adalah zona tekan. Bukti tertulis ada di Pasal 18.10.6.4 untuk 

detailing confinement, Pasal 18.10.6.3 untuk dimensi elemen batas, dan Pasal 18.7.5.4 

(Tabel 18.7.5.4) untuk rumus tulangan transversal yang diterapkan pada boundary 

elements shear wall. 
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G. Pengecekan Pada Taraf Penjepitan (Rasio Runtuh Geser 
dan Lentur) 

Rasio keruntuhan geser dan lentur pada shear wall menurut SNI 2847:2019 

merujuk pada klasifikasi mode kegagalan berdasarkan aspek rasio dinding (hw/lw), 

di mana hw adalah tinggi dinding dan lw adalah panjang dinding. Jika rasio hw/lw 

kurang dari 2, dinding cenderung mengalami keruntuhan geser (shear-dominated 

failure) yang bersifat brittle, karena gaya lateral lebih banyak ditahan oleh kekuatan 

geser daripada momen lentur. Sebaliknya, jika rasio hw/lw lebih besar atau sama 

dengan 2, dinding diklasifikasikan sebagai dinding langsing atau flexural wall, di 

mana keruntuhan cenderung lentur (flexural-dominated failure) yang lebih ductile, 

memungkinkan deformasi besar sebelum runtuh. Klasifikasi ini penting untuk 

menentukan pendekatan desain agar struktur tetap aman di daerah seismik. 

Untuk membuktikan keberadaan ketentuan ini, rasio keruntuhan geser dan 

lentur dibahas dalam Pasal 18.10 SNI 2847:2019, khususnya subpasal 18.10.1 hingga 

18.10.4 yang mengatur klasifikasi dinding berdasarkan aspek rasio dan kekuatan 

geser. Pasal ini menjelaskan bagaimana rasio hw/lw menentukan apakah dinding 

lebih rentan geser atau lentur, serta cara menghitung Ve untuk memprioritaskan mode 

lentur. Selain itu, Pasal 11.5 dan 11.6 melengkapi untuk desain umum nonseismik, 

tetapi fokus seismik ada di Pasal 18. 

Untuk mengetahui apakah desain dinding geser ini termasuk tipe keruntuhan 

geser ataupun flexural wall, terlebih dahulu harus mengetahui rasio antara hw/lw dari 

shear wall tersebut. Di bawah ini adalah hasil rasio geser dan lentur. 
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